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Upgrading the MG 9000

This document contains upgrade and downgrade information and 
procedures for the MG 9000 cards and the MG 9000 Manager. 

When to use this document 
Use this document when it is necessary to upgrade the MG 9000 
Manager and the MG 9000. Separate upgrade procedures are provided 
in this document that fit different upgrade scenarios as noted below:

• upgrading the MG 9000 Manager and MG 9000 from SN06.2 or 
SN06 to SN07. Throughout this document, substitute SN06 or 
SN06.2 for SN06.x as appropriate depending on the release from 
which you are upgrading.

• downgrading the software in the MG 9000 Manager and MG 9000

• upgrading the MG 9000 Manger software to a maintenance release

• upgrading the MG 9000 cards individually

• upgrading the MG 9000 cards by card type

• upgrading all the MG 9000 cards

When upgrading the MG 9000 Manager and MG 9000 from SN06.x to 
SN07, the following list provides an overview of upgrade activities which 
occur in the following order:

• upgrade the MG 9000 Manager master server and mid-tier software

• upgrade the OM Collector

• install the GUI client application

• provision userids

• export SN06.2 data to XML file

• upgrade MTA and xDSL cards

• upgrade software in MG 9000 cards

• import SN06.2 data from XML file

• remove SN06.2 software packages
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Before proceeding to the upgrade checklist and any upgrade 
procedures, ensure all the information in this section is read and 
understood. The order for upgrading the MG 9000 and the MG 9000 
Manager is presented in the MG 9000 Manager and MG 9000 SN06.x 
to SN07 upgrade checklist (one-server) on page 13 or MG 9000 
Manager and MG 9000 SN06.2 to SN07 upgrade checklist (two-server) 
on page 26. This checklist provides the required order and refers to 
specific procedures in this document and other documents while also 
providing simple steps for activities that must be performed at that time. 

Note: The above referenced checklist provides a high level 
procedure that provides the steps required for the upgrade of both 
the MG 9000 Manager and the MG 9000 from SN06.x to SN07. 
Specific upgrade procedures are provided for the MG 9000 Manager 
and the MG 9000 later in this document.

Upgrade strategy
The following provides a high-level strategy for software upgrades of the 
MG 9000 Manager and the MG 9000 to SN07 which are accomplished 
in the following order in relation to other components in the solution:

1. The Communication Server 2000 (CS2000) Management Tools 
must be upgraded to SN07 to ensure node and line provisioning 
applications are updated. Refer to ATM Solutions Upgrades, 
NN10261-450 or IP Solutions Upgrades, NN10344-450.

2. The Succession Server Platform Foundation Software (SSPFS) 
must be upgraded to SN07. Refer to “Upgrading SSPFS Software” 
in ATM Solutions Upgrades, NN10261-450 or IP Solutions 
Upgrades, NN10344-450. This includes the SSPFS on the 
MG 9000 Manager master and mid-tier servers.

Note: After the SSPFS platform software is upgraded to SN07 
and the MG 9000 Manager restarts in SN06.x (step 1), and 
CS2000 Management Tools have been upgraded to SN07, the 
MG 9000 Manager server and mid-tier software can be upgraded 
(step 3).

3. The MG 9000 Manager software must be upgraded in the following 
order: server, mid-tier.

4. All the MG 9000 intelligent cards are upgraded to SN07 from an 
image received on CD using the Software Upgrade tool accessible 
from the Frame View.
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5. The newly updated MG 9000 network element must be added to 
SN07. 

6. Delete the MG 9000 network element being updated from SN06.x 
in the SN06.x Subnet View. 

7. Once the MG 9000 is in the SN07 Subnet View, and the network 
element is deleted from the SN06.x Subnet View, any new 
hardware can be added into the system.

8. Remove old SN06.x packages.

Service impacts
The following are the service impacts to consider when proceeding with 
the upgrade:

• Warnings for all components and services impacted during upgrade

— No data provisioning should be performed during upgrades.

— PM collection cannot be performed during the time between 
stopping the mid-tier server and starting the OM Collector. 
During the time when the DCC cards have been upgraded to 
SN07 but the NE still resides in the SN06.x Subnet View, the 
SN06.x OM Collector will not collect any OMs because of 
security features added in the MG 9000 card software.

— During the time when the DCC cards have been upgraded to 
SN07 but the NE still resides in the SN06.x Subnet View, the 
node is not being managed. Alarms are going to the SN06.x 
MG 9000 Manager but any alarms specific to SN07 MG 9000 
card loads are being dropped. Once the NE is moved to SN07, 
all alarms even those dropped, will be shown in SN07.

— Call processing should not be impacted during the MG 9000 
Manager upgrade.

— During the time when the DCC cards have been upgraded to 
SN07 but the NE still resides in the SN06.x Subnet View, ESA 
data download should not be performed. ESA data download 
cannot work because of a security functionality added in the 
SN07 MG 9000 card load. The SN06.x MG 9000 Manager does 
Upgrading the MG 9000
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not have this security functionality. Once the MG 9000 is 
imported into SN07, ESA downloads can be performed.

— During a downgrade, the GWC cannot be downgraded until all 
MG 9000s that subtend it are downgraded.

— OC3 carriers must not be in split-mode, refer to procedure 
“Recovery from APS Split-mode” in MG 9000 Fault 
Management, NN10074-911.

— Prior to downgrading to SN06.x, the hardware versions should 
be checked to ensure that the PEC codes are not for the new 
SN07 hardware. If the new hardware is not removed, the SN06.x 
loads will be FTP’d to the boards but they will not run. Also, if the 
OC3 ports have been channelized, they must be manually 
provisioned to OC-3 concatenated prior to downgrading. Refer 
to the following table to identify the PEC codes for SN07 cards.

• Recommendations for limiting service impact: none

Upgrade and downgrade time factors
When preparing for an upgrade from SN06.x to SN07, time is a 
consideration. The factors affecting the upgrade and the amount of time 
involved are provided in the following table. In addition, formulae for 
computing upgrade and downgrade times for the MG 9000 Manager 
are provided in the table.

SN07 upgrade PEC codes

Card type
Pre-SN07 PEC 
codes

SN07 new hardware 
PEC codes

ITP NTNY30AA or
NTNY30BA (IP)

NTNY30BA or
NTNY30CB

ITX NTNY41AA NTNY41BA

DS-512 ABI NTNY43AA NTNY43BA or 
NTNY43BB

DCC-OC3 (SCO) NTNY45AA NTNY45CA

Hybrid DCC-OC3 
(OC3)

NTNY45AA

DCC-DS1IMA (SCI 
hybrid)

NTNY45BA NTNY45BA
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Upgrade procedure information:

• datafill changes required during upgrade: none required

• recommended soak time: 24 hours

• total upgrade time, high level estimates (worst case):

Note: The following estimates are based on MG 9000s with 
55,000 lines maximum.

— upgrade - 182 minutes, 16 NEs

— downgrade - 160 minutes, 16 NEs

Use the information in the following table to compute the upgrade 
and downgrade activities.

Computing upgrade and downgrade times

Activity Variables Formula
Value (in 
minutes)

Upgrade

MG 9000 Manager upgrade time = 

(n x X) + ED + ER + EA + EeP + (n x I) + (n x P)

where:

n is the number of network elements (assumes 
worst case of an 8 shelf NE)

X is the time to export an 8 shelf NE 1:20

I is the time to import a single 8 shelf NE 6:30

ED is the time to take the MG 9000 Manager down 1:21

ER is the time to perform the SUN package 
remove

1:00

EA is the time to perform the SUN package add 4:00

EeP is the time to edit the Subnet Persistence file 1:00

ES is the time to start the MG 9000 Manager 1:21

P is the time to persist a single 8 shelf NE 3:00
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Tools and utilities
The MG 9000 and the MG 9000 Manager software support software 
upgrades and downgrades. Procedures in this document support these 
activities. The MG 9000 and MG 9000 Manager support patching 
through the network patch manager (NPM). Procedures for patching 
the MG 9000 and the MG 9000 Manager are provided in ATM Solutions 
Upgrades, NN10261-450 or IP Solutions Upgrades, NN10344-450.

The MG 9000 Manager provides a tool to upgrade the software in the 
intelligent DCC, ITX, ITP, DS-512 (ABI), and DS1 cards. A single card 
or multiple cards can be upgraded using this tool.

In addition, the software in the xDSL and MTA cards can be 
downloaded into the cards using the Software Download tool available 
from the xDSL and MTA Card Views in the MG 9000 Manager. 
Procedures for downloading software into the xDSL and MTA cards are 
provided in this document.

SC is the static components = sum of ED = 
ER + EA + EeP + ES

8:42

Example computation:

MG 9000 Manager upgrade time for 16k line network (all 8 shelves) = 

(4 x 1:20) + SC + (4 x 6:30) + (4 x 3:00) = 

(5:20) + (8.42) + (26) + (12:00) = 52 minutes

Downgrade

MG 9000 Manager downgrade time = 

ED + ER + EA + EeP + ES + (n x I) + (n x P)

Note: If an export is performed for one or more NEs between the 
MG 9000 Manager upgrade and the abort, no data will be available 
from the MG 9000 Manager for the downgraded NEs.

Computing upgrade and downgrade times

Activity Variables Formula
Value (in 
minutes)
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MG 9000 Manager client system requirements
Recommended minimum configurations for the MG 9000 Manager 
client are provided in the following table.

MG 9000 Manager client minimum configurations

Client platform Configuration

Windows client • Windows NT 4.0 (SP5 or later), Windows 2000 (SP2 or later), 
or Windows XP

• Pentium III 1 GHz or higher

• display resolution of 1280 x 1024 with 256 colors

• 256 MB RAM

• 200 MB hard drive space

• 10BaseT/100BaseT Ethernet network connection

• Java Web Start (JWS) 1.2.0_02 and higher

If the Windows PC supports more Succession client applications 
than just the MG 9000 Manager client application, the following 
minimum configuration is required:

• Windows 2000 (SP2 or later), or Windows XP

• Pentium III 2.5 GHz or higher

• display resolution of 1280 x 1024 with 256 colors

• 1 Ghz RAM

• 30 Gb hard drive space

• 10BaseT/100BaseT Ethernet network connection

• Java Runtime Environment (JRE) 1.4.1_02 and higher

• Java Web Start (JWS) 1.4.2_05 and higher

Solaris client • Solaris 7 or Solaris 8 with Sun recommended patches for 
Java Runtime Environment (JRE) 1.4.1_02

• Ultra 5 400 MHz or higher

• display resolution of 1280 x 1024 with 256 colors

• 256 MB RAM

• 200 MB hard drive space

• 10BaseT/100BaseT Ethernet network connection
Upgrading the MG 9000
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Pre-upgrade requirements
Ensure the CS 2000 Manager has been upgraded to SN07 before 
upgrading any MG 9000s to SN07.

The MG 9000 Manager must be upgraded to SN07 first. This means the 
MG 9000 Manager is capable of managing an MG 9000 operating at 
SN07. However, this does not mean an MG 9000 at the SN06.x release 
is managed by an MG 9000 Manager at SN07. The MG 9000 is 
upgraded to SN07 and the network element (NE) representing the 
MG 9000 is moved from the SN06.x subnet to the SN07 subnet. An 
SN07 subnet/MG 9000 Manager cannot manage an MG 9000 at 
SN06.x.

Note: All alarms on the MG 9000 Manager and MG 9000 network 
element must be cleared prior to proceeding with the SN06.x to SN07 
upgrade process.

Do not provision any new data to the NEs during upgrade activities.

Windows or 
Solaris client

Third party software

• Netscape 6.0 and higher or Internet Explorer 5.5, 6.0 and 
higher

• Java Web Start (JWS) 1.2.0_02 and higher

Note: Access to some functions requires the use of SSH compatible client software 
for access to secure telnet and ftp services (using SSH standard). SSH clients are 
supplied bundled with some operating systems, but may need to be obtained 
separately. Sources for SSH clients include, but are not limited to the following:

• PUTTY - freeware

• OpenSSH - freeware

• SSH Inc. - commercial

• Secure CRT - commercial

• WinSCP - freeware

Nortel Networks does not supply or recommend a particular supplier.

MG 9000 Manager client minimum configurations

Client platform Configuration
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Entry criteria
The following are the criteria for entering the SN06.x to SN07 upgrade 
process:

• host names and IP addresses required for:

— the MG 9000 Manager mid-tier server

— the MG 9000 Manager server

— the CS 2000 Manager (Oracle database), required

— the Security Authentication Host, typically the mid-tier IP 
address

— the Imaging FTP Server Host, typically the SDM
• user id and password for the Imaging FTP Server Host, must have 

overwrite privileges

• hardware and software baseline:

— MG 9000 card loads must be at SN06.x with all patches applied

— MG 9000 Manager software must be at SN06.x with all patches 
applied and enabled

• tools required: database browser (optional)

• upgrade interdependency:

— SSPFS on MG 9000 Manager master and mid-tier servers must 
be upgraded to SN07. SSPFS upgrades are covered in ATM 
Upgrading the MG 9000
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Solutions Upgrades, NN10261-450 or IP Solutions Upgrades, 
NN10344-450.

— CS 2000 Management Tools must be upgraded to SN07 prior to 
upgrading the MG 9000 Manager to SN07.

— MG 9000 card upgrades are addressed in Upgrading software in 
MG 9000 cards on page 97

— ensure MG 9000 PSEs are configured correctly before the 
upgrade starts. This requires the following steps:

Note: If this is an N240 server, configure PSE on the 
workstation. If this is a t1400 server, configure PSE on the 
master and mid-tier servers.

– telnet to the specific machine to be upgraded by typing
> telnet <server ip address> 

– change to the root directory by typing
$ su - root 

– Access the command line interface by typing 
> cli 

– To select Configurations, type
> 2 

– To select Succession Element Configuration, type
> 14 

– To select PSE Configurations, type
> 1 

– To select View PSE Configuration, type
> 1 

– Ensure the PSE application is pointing to the CS 2000 
Management Tools machine where NPM is running. If it is not 
configured correctly, reconfigure the PSE to point to the 
CS 2000 Management Tools machine where the NPM is 
running. Refer to “Upgrading the SSPFS Software” in ATM 
Solutions Upgrades, NN10261-450 or IP Solutions 
Upgrades, NN10344-450. 

• datafill changes required prior to upgrade: All NEs which are being 
upgraded to SN07 may have their SN06.x data exported prior to 
upgrading. This is optional. However, no provisioning including 
OSSGate should occur between the point where the SN06.x data is 
exported and the node is imported in SN07. If data provisioning 
does occur, the SN06.x data can be exported again and this will 
NN10048-461   (I)SN07   Standard 06.02 December, 2004
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overwrite the old SN06.x data. Refer to step 9 in the MG 9000 
Manager and MG 9000 SN06.x to SN07 upgrade checklist 
(one-server) on page 13 or step 14 in MG 9000 Manager and MG 
9000 SN06.2 to SN07 upgrade checklist (two-server) on page 26.

• if this is an SN06x to SN07 Sun Netra cluster (two-server) upgrade, 
run a getpatch to retrieve all SN07 patches before the upgrade 
starts. Refer to “Transferring patches to the NPM database 
manually” in ATM Solutions Upgrades, NN10261-450 or IP 
Solutions Upgrades, NN10344-450. 

Exit criteria
The following are the criteria for exiting from the SN06.x to SN07 
upgrade process:

• The upgrade was successful 

— after the MG 9000 Manager mid-tier server and server 
applications are running in SN07

— after the NE is successfully discovered in SN07

• Recommended testing

— Make sure alarms are received (temporarily set a cooling unit 
breaker on the IBIP to off).

— Select a VMG from the Switched Line Services View. Select a 
termination and make sure that the termination properties show 
correctly.

— Select a Private lines service, if provisioned, and get the 
properties for it. Make sure the Svc OperStatus from the Service 
Properties View is connected for full and active endpoint 
services

• Log reports or operational measurements (OM): check the 
customer logs for audit messages indicate clean up failures.

• Equipment state verification: access the Oracle database and verify 
the same number of terminations exists (optional).
Upgrading the MG 9000
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Applying software fixes
When it is necessary to apply software fixes, the following methods are 
available:

• Maintenance Release upgrade process: refer to the procedure 
Upgrading the MG 9000 Manager software to a maintenance 
release on page 76

• Patching

— SN07 patching of the MG 9000 Manager is handled as noted in 
Patching MG 9000 Manager software on page 87
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MG 9000 Manager and MG 9000 SN06.x to SN07 upgrade checklists

SN06.x to SN07 t1400/N240 one-server (simplex) upgrade checklist
Use the following table as a checklist for upgrading the MG 9000 
Manager and MG 9000 from SN06.x to SN07 in a t1400/N240 
single-server (simplex) configuration. Enter a check mark (√ )  in the √ 
column as each step or procedure is completed.

MG 9000 Manager and MG 9000 SN06.x to SN07 upgrade checklist (one-server)

Activity Procedure √

1 Upgrade the 
MG 9000 Manager 
to SN07. 

1. The following steps are part of the procedure 
Upgrading MG 9000 Manager software from SN06.x 
to SN07 on page 41. Refer to that procedure and 
those referenced in the following steps to complete the 
MG 9000 Manager upgrade.

a. Configure the MG 9000 Manager master server 
by performing procedure Configuring the MG 
9000 Manager master server software on 
page 57.

b. Configure the MG 9000 Manager mid-tier server 
by performing procedure Configuring the MG 
9000 Manager mid-tier server software on 
page 62.

c. Install the MG 9000 Manager client software

• For Windows PC client installation, refer to 
Installing the MG 9000 Manager Windows PC 
client software on page 64

• For Sun workstation client installation, refer to 
Installing the MG 9000 Sun client software on 
page 66

d. Provision any new users, if required. Refer to MG 
9000 Security and Administration, NN10162-611.

Note: Previous SN06.x users are maintained 
through the upgrade.
Upgrading the MG 9000
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1 Upgrade the 
MG 9000 Manager 
to SN07. 
(continued)

e. Start the SN06.x MG 9000 Manager client. Refer 
to MG 9000 MG 9000 Security and 
Administration, NN10162-611.

f. Start the SN07 MG 9000 Manager client. Refer to 
MG 9000 MG 9000 Security and Administration, 
NN10162-611

Note 1: During the upgrade process, when the 
user clicks on the SN07 link in the Application 
Launch Point, the SN07 application launches. At 
that point, the user must login. This allows the 
user into the SN07 application. However, when 
the SN06.x link is selected, a second and different 
login box appears, meaning the user must log in 
again to access the SN06.x application. This only 
occurs during this upgrade session.

Note 2: SN06.x and SN07 can run 
simultaneously.

Note 1: This is a safe stopping point

Note 2: Before proceeding, ensure the GWC has been upgraded by referring 
to the “Overall upgrade procedure” in Upgrading the GWC, NN10196-461.

MG 9000 Manager and MG 9000 SN06.x to SN07 upgrade checklist (one-server)

Activity Procedure √
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For each network element in SN06.x

2 Ensure all MG 
9000 Patch Image 
(9PI) load files 
have been copied 
to the CS2000 
Core Manager 
(SDM) to support 
upgrade / 
downgrade activity 
from DAT tape or 
CD-ROM.

Refer to “Upgrading the CS S2000 Core Manager, 
NN10060-461.”

Refer to Installing MG 9000 loads into the CS 2000 Core 
Manager from DAT tape on page 90 or Installing MG 9000 
loads into the CS 2000 Management Tools Manager from 
CDROM on page 92.

3 Provisioning a 
floating IP 
address.

Refer to Provisioning a floating IP address on page 94.

4 Upgrade the MTA 
card, if equipped.

Perform the procedure Downloading software into the MTA 
card on page 141.

5 Upgrade the xDSL 
cards, if equipped

Perform the procedure Downloading software into the 
xDSL card on page 143.

6 Determine if the 
sync reference/ 
timing signal 
source is correct. 
This must be 
correct to prevent 
alarms on the DCC 
and ITP cards 
when the upgrade 
is complete.

If the BITS cable was connected to the DCC card BITS 
connector during the hardware installation, using the Local 
Craft Interface (LCI) access the master shelf in the 
network element being upgraded, and select the active 
ITP card. From the menu, select Clock 
Sync->Provisioning. Ensure the MG 9000 is synched to 
the correct timing source, BITS or network:

• ITXBITS - if syncing to the ITX card

• DCCBITS - if syncing to the DCC cards and the cable 
is connected to the DCC card BITS connector

• Network - if syncing to the upstream network 
connection

Refer to MG 9000 Configuration Management, 
NN10096-511.

MG 9000 Manager and MG 9000 SN06.x to SN07 upgrade checklist (one-server)

Activity Procedure √
Upgrading the MG 9000
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7 Perform a card 
upgrade in the 
SN06.x subnet on 
the following cards 
on the NE: all 
DS1s, ABIs, ITPs, 
ITXs, and DCCs. 

Perform the procedure Upgrading the MG 9000 from 
SN06.x to SN07 on page 135.

8 Determine if the 
DCC cards 
software version is 
at 7.

From the Frame view, click on Actions->Software 
Upgrades in the menu bar. From the Software Upgrades 
view, click on Version List. Check the version of the DCC 
cards or click on the frame, shelf, card to view each DCC 
and make sure the software version indicates 7. Both DCC 
cards must be at the SN07 software version.

Note 1: Upgrade should not progress until both DCC card 
versions are SN07.

Note 2: Once the MG 9000 has been upgraded to SN07, 
no further provisioning should occur.

MG 9000 Manager and MG 9000 SN06.x to SN07 upgrade checklist (one-server)

Activity Procedure √
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9 Export data to 
XML file.

Wait for the Export 
To XML File 
window to indicate 
that the export is 
complete.

In the SN06.x Subnet View, select the MG9000 menu and 
click on Export NE. From the ExportNE Contents to XML 
File window, select an NE and click on Export. Refer to 
Performing an Export NE on page 71.

Look for: Completed XML Export of NE: <ne number>

Note 1: After the exports are complete, tar the entire 
persistdata directory, located on the MG 9000 master 
server, and place the exported data onto another machine 
for vaulting purposes. The following files and directories 
may be present in the persistdata directory:

• LoadFilesPersistData.dat

• xml

• ESA_SYSTEM_SD_V1.0.DTD

Note: ESA_SYSTEM_SD_V1.0.DTD is generated 
only for SN06.2 MG 9000 Manager data, not for the 
SN06 MG 9000 Manager data.

• SubnetPersistData06_2.dat 

Use the following information to tar the persistdata files 
and directories

tar cvf <filename>.tar /data/mg9kem/persistdata

It is recommended that the filename use the following 
format: 

<date.hostname_filename>.tar 

for example, 

OCT23.rtpd_persistdatabackup.tar 

Note 2: Keep a backup copy of the SN06.x XML file in 
case a downgrade is required.

Note: This is a safe stopping point.

MG 9000 Manager and MG 9000 SN06.x to SN07 upgrade checklist (one-server)

Activity Procedure √
Upgrading the MG 9000
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10 Remove the NE 
from the SN06.x 
OMC collection 
list.

Once the DCC cards are at SN07, no OMs can be 
collected until the NE is imported to the SN07 Subnet 
View. 

1. To remove the NE from the SN06.X OMC collection 
list perform the following steps at the MG 9000 
Manager mid-tier workstation:

a. To configure the OM collector, type
# 
/opt/nortel/omcltr_06_2/bin/OMCollec
tor config 

The system responds 

Starting OM Configuration Tool ...
************************************
********************
* Welcome to the Nortel Networks *
* 
* OM Collection Configuration Tool *
************************************
**********************
  
Please pick one of the following 
options: 

[C]reate a new device collection list
[A]dd device(s) to the collection 
list
[R]emove device(s) from the 
collection list
[D]isplay the existing collection 
list 
[S]how this menu again
[P]assword configuration
[H]elp menu
e[X]it

Enter your selection:

b. To display the NEs the OM Collector is 
supporting, type
> D 

Identify the NE to be removed from the collection 
list.

MG 9000 Manager and MG 9000 SN06.x to SN07 upgrade checklist (one-server)

Activity Procedure √
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10 Remove the NE 
from the SN06.x 
OMC collection 
list. (Contd)

c. To remove the NE from the OM Collector, type 
> R 

The system responds with:

Enter IP address (X.X.X.X) or <ENTER> 
to end:

d. Type the IP address of the NE to remove.

The system responds with:

Enter IP address (X.X.X.X) or <ENTER> 
to end: 

Note: Each NE should be removed as it is 
upgraded. 

e. Press <ENTER> to end.

The system responds with:

Deletion of device(s) is complete.

Please pick one of the following 
options: 

[C]reate a new device collection list
[A]dd device(s) to the collection 
list
[R]emove device(s) from the 
collection list
[D]isplay the existing collection 
list
[S]how this menu again
[P]assword configuration
[H]elp menu
e[X]it
Enter your selection:

f. To exit the tool, type X.

The system responds with:

************************************
******************
*** OM Collection Configuration Tool 
is closing... ***
************************************
******************

MG 9000 Manager and MG 9000 SN06.x to SN07 upgrade checklist (one-server)

Activity Procedure √
Upgrading the MG 9000
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11 Create patched 
images of all 
MG 9000 loads

1. After the MG 9000 cards have been upgraded to SN07 
and all other MG 9000 Manager workstations have 
been upgraded to SN07, perform the following 
procedure to image the network element (NE) cards 
for use in upgrading the cards in other NEs.

Note 1: Perform the following steps after the following 
conditions are met:

• the NPM is at SN07

• the suite of MG 9000 Manager servers are 
running SSPFS07, with both SN06.x and SN07 
MG 9000 Managers are resident

• the old SN06.x MG 9000 Manager is not in control 
of the MG 9000 devices which are running SN07

Note 2: The following steps will create patched 
images of all MG 9000 loads. This will be 
accomplished by upgrading, patching, and then 
imaging two MG 9000s (one DCC-OC3 MG 9000 and 
one DCC-DS1-IMA MG 9000). Ensure the NEs 
selected include all MG 9000 intelligent card types in 
the office. 

First the user will upgrade all the intelligent cards on a 
DCC-OC3 MG 9000 using the latest available PI 
loads. After the upgrade, the user will patch all 
intelligent cards on the DCC-OC3 MG 9000 with any 
available patches that were not included on the PI load 
tape. After patching is complete, the user will take an 
image of the DCC-OC3 MG 9000 using the NPM.

Next, the user will upgrade a DCC-IMA MG 9000 
using the PI loads just created. After the upgrade, the 
user will apply any available patches for any remaining 
intelligent card types (including the DCC-DS1-IMA) 
that were not patched during the DCC-OC3 MG 9000 
upgrade. After patching is complete, the user will take 
an image of the DCC-DS1-IMA MG 9000 using the 
NPM.

a. Use the following to determine the next step.

• if there were additional patches added to the 
pre-patched image loadfile, go to step c

• if there were no additional patches added to 
the pre-patched image loadfile, go to step b

MG 9000 Manager and MG 9000 SN06.x to SN07 upgrade checklist (one-server)

Activity Procedure √
NN10048-461   (I)SN07   Standard 06.02 December, 2004



Nortel Networks Confidential21Copyright © 2004, Nortel Networks
11 Create patched 
images of all 
MG 9000 loads 
(contd)

b. Apply remaining SN07 patches to all cards on this 
NE with DCC OC3 cards.

c. Import this NE with DCC OC3 cards to the SN07 
MG 9000 Manager.

Note: Make sure an audit is not in progress and 
is not scheduled for this NE. 

Go to the SN07 Subnet View and click on the 
MG9000 menu and click on Import NE.

From the Import From XML File window, select the 
SN06.x import path 

/data/mg9kem/persistdata/xml/SN06/<ne_num
ber> for SN06, 

or

/data/mg9kem/persistdata/xml/SN06_2/<ne_n
umber> for SN06_2

which is to be upgraded. 

Select Import. This will import and convert all the 
SN06.2 data which was previously exported. The 
NE icon will be created and a discovery/recovery 
process is started.

Refer to Performing an Import NE on page 69.

d. Take an image of the inactive cards on this NE 
with DCC-OC3. Refer to the “Performing a device 
image using the NPM” in ATM Solutions Upgrade, 
NN10261-450 or IP Solutions Upgrade, 
NN10344-450 for steps on performing a device 
image. Select SmartImage->MG9KDEVICES.

e. Upgrade one NE with DCC-DS1-IMA cards with 
the SN07 MG 9000 patched images just created 
in the previous step. Load all cards on this NE with 
the supplied image.

MG 9000 Manager and MG 9000 SN06.x to SN07 upgrade checklist (one-server)

Activity Procedure √
Upgrading the MG 9000
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11 Create patched 
images of all 
MG 9000 loads 
(contd)

f. Import this NE with DCC DS1-IMA cards to the 
SN07 MG 9000 Manager.

Note: Make sure an audit is not in progress and 
is not scheduled for this NE. Observe the Audit 
Tasks tab in the Frame View.

Go to the SN07 Subnet View and click on the 
MG9000 menu and click on Import NE.

From the Import From XML File window, select the 
SN06.x import path 

/data/mg9kem/persistdata/xml/SN06/<ne_num
ber> for SN06, 

or

/data/mg9kem/persistdata/xml/SN06_2/<ne_n
umber> for SN06_2

which is to be upgraded. 

Select Import. This will import and convert all the 
SN06.2 data which was previously exported. The 
NE icon will be created and a discovery/recovery 
process is started.

Refer to Performing an Import NE on page 69.

g. Apply the remaining patches to all cards on this 
NE with DCC DS1-IMA cards.

h. Take an image of the inactive cards on this NE 
with DCC DS1-IMA cards that were not imaged in 
step d above. Refer to the “Performing a device 
image using the NPM” in ATM Solutions Upgrade, 
NN10261-450 or IP Solutions Upgrade, 
NN10344-450 for steps on performing a device 
image. Select SmartImage->MG9KDEVICES.

i. Use the images created in the previous steps to 
upgrade all the of the cards on all the remaining 
NEs to be upgraded to SN07

MG 9000 Manager and MG 9000 SN06.x to SN07 upgrade checklist (one-server)

Activity Procedure √
NN10048-461   (I)SN07   Standard 06.02 December, 2004



Nortel Networks Confidential23Copyright © 2004, Nortel Networks

 

12 Enable OM 
collection for NEs 
in SN07

If this is the first NE to be upgraded, configure the 
OMCollector using the “Configuring OM Collector 
software” in MG 9000 Performance Management, 
NN10140-711. 

As each NE is upgraded, OM Collection for that NE must 
be enabled by clicking the OMCollection checkbox in the 
MG 9000 Provisioning View which is accessed from 
Configuration->View/Modify NE Properties from the menu 
bar of the Subnet View for OM Collection to be enabled for 
an NE. For more information refer to MG 9000 
Performance Management, NN10140-711. 

13 Delete the NE 
which was just 
upgraded.

Go to the SN06.x Subnet View. Select the NE to be 
deleted and from the menu bar, select 
Configuration->Delete NE. Click on Apply, OK as needed 
and exit. 

Refer to the “Deleting an MG 9000 network element” 
procedure in MG 9000 Configuration Management, 
NN10096-511.

14 Configure 
Enhanced ESA, if 
applicable (only 
applies to North 
America)

Go to the Switched Lines Services GUI and change the 
VMGs to support Enhanced ESA.

Refer to the “Provisioning ESA” procedure in MG 9000 
Configuration Management, NN10096-511.

Note: This is a safe stopping point.

After all NEs are at SN07 and there is no need to downgrade to SN06.x proceed to the 
next step: 

Note: If it is necessary to downgrade the MG 9000 and MG 9000 Manager, perform the
Downgrading the MG 9000 Manager from SN07 to SN06.x on page 73 procedure, 
otherwise proceed to the next step.

MG 9000 Manager and MG 9000 SN06.x to SN07 upgrade checklist (one-server)

Activity Procedure √
Upgrading the MG 9000
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15 Run the pkgrm 
script on each 
server (master 
server and mid-tier 
server) to stop the 
SN06.x server 
application and 
uninstall the server 
application. The 
OM Collector 
software is located 
on the mid-tier 
server.

Note: Once the 
packages have 
been removed, it 
will not be possible 
to downgrade 
without 
re-importing a 
saved data image 
and a resulting 
loss of service.

1.

Perform the following steps:

a. Login as root.

b. To stop the SN06.x mid-tier server, type

for SN06
> /opt/nortel/mg9kmtr_06/bin/mg9kmid
tier stop

for SN06.2
> servstop MG9KMIDTIER_06_2 

c. To stop the SN06.x master server, type

for SN06
> /opt/nortel/mg9ksrv_06/bin/mg9kser
ver stop 

for SN06.2
> servstop MG9KSERVER_06_2 

d. To stop the SN06.x OM collector, which is located 
on the mid-tier server, type

for SN06
> /opt/nortel/OMCollector/bin/OMColl
ector stop 

for SN06.2
> servstop MG9KOMC_06_2 

e. To remove the master server SN06.x software, 
type

for SN06
> pkgrm NTmg9ks06 

for SN06.2
> pkgrm NTmg9ks62 

To continue, respond to the two prompts with Y.

MG 9000 Manager and MG 9000 SN06.x to SN07 upgrade checklist (one-server)

Activity Procedure √
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15 Run the pkgrm 
script on each 
server (continued) f. To remove the mid-tier server SN06 software, 

type

for SN06
> pkgrm NTmg9km06 

for SN06.2
> pkgrm NTmg9km62 

To continue, respond to the prompt with Y.

g. To remove the OM collector SN06.2 software from 
the mid-tier server, type

for SN06
> pkgrm NTomcltr 

for SN06.2
> pkgrm NTomclt62 

To continue, respond to the two prompts with Y.

Note: After step 15 is performed, the MG 9000s cannot be downgraded to 
SN06 without service data loss.

Note: Proceed to the next step only after the one night process (ONP) is 
complete.

16 After each node is 
upgraded to SN07, 
FTP the ESA data 
to database.

To ensure ESA data is correct, FTP the ESA data to the 
database. Refer to “Downloading ESA data from the Core” 
in MG 9000 Configuration Management, NN10096-511.

17 Clean up old data 
in the NPM 
database.

Perform the procedure “Cleaning up old data in the NPM 
database” in ATM Solutions Upgrades, NN10261-450 or 
IP Solutions Upgrades, NN10344-450. 

18 This procedure is complete.

MG 9000 Manager and MG 9000 SN06.x to SN07 upgrade checklist (one-server)

Activity Procedure √
Upgrading the MG 9000
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SN06.2 to SN07 N240 two-server (cluster) upgrade checklist
Use the following table as a checklist for upgrading the MG 9000 
Manager and MG 9000 from SN06.2 to SN07in a two-server (cluster) 
configuration. Enter a check mark (√ )  in the √ column as each step or 
procedure is completed.

MG 9000 Manager and MG 9000 SN06.2 to SN07 upgrade checklist (two-server)

Activity Procedure √

On the Inactive node

Note:  Ensure getpatch has been run on all SN07 patches that are applicable 
for the new SN07 applications prior to proceeding with the upgrade to SN07

Refer to “Transferring patches to the NPM database manually” in ATM Solutions 
Upgrades, NN10261-450 or IP Solutions Upgrades, NN10344-450. 

1 Upgrade the 
Succession Server 
Platform 
Foundation 
Software (SSPFS).

Perform procedure Upgrading SSPFS software in ATM 
Solutions Upgrades, NN10261-450 or IP Solutions 
Upgrades, NN10344-450.

2 Install any SSPFS 
MNCLs. 

Note: Only 
perform this step if 
you received a 
notification bulletin 
that an SSPFS 
MNCL is available 
for the release you 
just upgraded.

Refer to the instructions provided with the MNCLs.
NN10048-461   (I)SN07   Standard 06.02 December, 2004
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3 Upgrade the 
MG 9000 Manager 
to SN07. 

1. Perform the following steps to complete the MG 9000 
Manager upgrade.

a. Telnet to the specific machine to be upgraded by 
typing
> telnet <server ip address> 

b. Login as root

c. To verify you are on the inactive node, type
> bash 

d. To verify all applications have stopped, type
> servquery -status all 

e. To verify if the node in the cluster is active or 
standby unit, type
> ubmstat 

f. To verify the unit is in standby and is in a normal 
state
> udstat 

g. Perform procedure Upgrading MG 9000 Manager 
software from SN06.x to SN07 on page 41.

h. Configure the MG 9000 Manager master software 
by performing procedure Configuring the MG 
9000 Manager master server software on 
page 57.

i. Configure the MG 9000 Manager mid-tier 
software by performing procedure Configuring 
the MG 9000 Manager mid-tier server software 
on page 62.

j. Configure the network elements with the OM 
collector. Refer to the “Installing OM Collector 
software” in MG 9000 Performance 
Management, NN10140-711.

k. Provision any new users, if required. Refer to MG 
9000 MG 9000 Security and Administration, 
NN10162-611.

Note: Previous SN06.2 users are maintained 
through the upgrade.

MG 9000 Manager and MG 9000 SN06.2 to SN07 upgrade checklist (two-server)

Activity Procedure √
Upgrading the MG 9000



Nortel Networks Confidential28Copyright © 2004, Nortel Networks
On the Active node

4 Stop the cluster. Perform procedure “Stopping a cluster in ATM Solutions 
Upgrades, NN10261-450 or IP Solutions Upgrades, 
NN10344-450.

On the newly Active node with SN07 software

5 Verify the node is 
the active unit and 
the health of the 
unit

To verify the node is the active unit by typing 
> ubmstat 

To check the health of the unit, type

> servquery -status all 

6 Launch client 
software from 
active node

1. Install the MG 9000 Manager client software

• For Windows PC client installation, refer to 
Installing the MG 9000 Manager Windows PC 
client software on page 64

• For Sun workstation client installation, refer to 
Installing the MG 9000 Sun client software on 
page 66

2. Start the SN06.2 MG 9000 Manager client. Refer to 
MG 9000 Security and Administration, NN10162-611.

3. Start the SN07 MG 9000 Manager client. Refer to MG 
9000 Security and Administration, NN10162-611.

Note 1: During the upgrade process, when the user 
clicks on the SN07 link in the Application Launch 
Point, the SN07 application launches. At that point, 
the user must login. This allows the user into the 
SN07 application. However, when the SN06.2 link is 
selected, a second and different login box appears, 
meaning the user must log in again to access the 
SN06.2 application. This only occurs during this 
upgrade session.

Note 2: SN06.2 and SN07 can run simultaneously.

MG 9000 Manager and MG 9000 SN06.2 to SN07 upgrade checklist (two-server)

Activity Procedure √
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7 Clone the image of 
the upgraded node 
onto the other node

Perform procedure “Cloning the image of one node in a 
cluster to the other node” in ATM Solutions Upgrades, 
NN10261-450 or IP Solutions Upgrades, NN10344-450. 

Note 1: This is a safe stopping point

Note 2: Before proceeding, ensure the GWC has been upgraded by referring 
to the “Overall upgrade procedure” in Upgrading the GWC, NN10196-461.

For each network element in SN06.2

8 Ensure all MG 
9000 Patch Image 
(9PI) load files 
have been copied 
to the CS2000 
Core Manager 
(SDM) to support 
upgrade / 
downgrade activity 
from DAT tape or 
CD-ROM.

Refer to “Upgrading the CS S2000 Core Manager, 
NN10060-461.”

Refer to Installing MG 9000 loads into the CS 2000 Core 
Manager from DAT tape on page 90 or Installing MG 9000 
loads into the CS 2000 Management Tools Manager from 
CDROM on page 92.

9 Provisioning a 
floating IP address.

Refer to Provisioning a floating IP address on page 94.

10 Upgrade the MTA 
card, if equipped.

Perform the procedure Downloading software into the 
MTA card on page 141.

11 Upgrade the xDSL 
cards, if equipped

Perform the procedure Downloading software into the 
xDSL card on page 143.

12 Perform a card 
upgrade in the 
SN06.2 subnet on 
the following cards 
on the NE: all 
DS1s, ABIs, ITPs, 
ITXs, and DCCs. 

Perform the procedure Upgrading the MG 9000 from 
SN06.x to SN07 on page 135.

MG 9000 Manager and MG 9000 SN06.2 to SN07 upgrade checklist (two-server)

Activity Procedure √
Upgrading the MG 9000



Nortel Networks Confidential30Copyright © 2004, Nortel Networks
13 Determine if the 
DCC cards 
software version is 
at 7.

From the Frame view, click on Actions->Software 
Upgrades in the menu bar. From the Software Upgrades 
view, click on Version List. Check the version of the DCC 
cards or click on the frame, shelf, card to view each DCC 
and make sure the software version indicates 7. Both 
DCC cards must be at the SN07 software version.

Note 1: Upgrade should not progress until both DCC 
card versions are SN07.

Note 2: Once the MG 9000 has been upgraded to SN07, 
no further provisioning should occur.

MG 9000 Manager and MG 9000 SN06.2 to SN07 upgrade checklist (two-server)

Activity Procedure √
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14 Export data to XML 
file.

Wait for the Export 
To XML File 
window to indicate 
that the export is 
complete.

In the SN06.2 Subnet View, select the MG9000 menu and 
click on Export NE. From the ExportNE Contents to XML 
File window, select an NE and click on Export. Refer to 
Performing an Export NE on page 71.

Look for: Completed XML Export of NE: <ne number>

Note 1: After the exports are complete, tar the entire 
persistdata directory, located on the MG 9000 master 
server, and place the exported data onto another machine 
for vaulting purposes. The following files and directories 
may be in the persistdata directory:

• LoadFilesPersistData.dat

• xml

• ESA_SYSTEM_SD_V1.0.DTD

Note: ESA_SYSTEM_SD_V1.0.DTD is generated 
only for SN06.2 MG 9000 Manager data, not for the 
SN06 MG 9000 Manager data.

• SubnetPersistData06_2.dat 

Use the following information to tar the persistdata files 
and directories

tar cvf <filename>.tar /data/mg9kem/persistdata

It is recommended that the filename use the following 
format: 

<date.hostname_filename>.tar 

for example, 

OCT23.rtpd_persistdatabackup.tar 

Note 2: Keep a backup copy of the SN06.2 XML file in 
case a downgrade is required.

Note: This is a safe stopping point.

MG 9000 Manager and MG 9000 SN06.2 to SN07 upgrade checklist (two-server)

Activity Procedure √
Upgrading the MG 9000
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15 Determine if the 
sync reference/ 
timing signal 
source is correct. 
This must be 
correct to prevent 
alarms on the DCC 
and ITP cards 
when the upgrade 
is complete.

If the BITS cable was connected to the DCC card BITS 
connector during the hardware installation, using the 
Local Craft Interface (LCI) access the master shelf in the 
network element being upgraded, and select the active 
ITP card. From the menu, select Clock 
Sync->Provisioning. Ensure the MG 9000 is synched to 
the correct timing source, BITS or network:

• ITXBITS - if syncing to the ITX card

• DCCBITS - if syncing to the DCC cards and the cable 
is connected to the DCC card BITS connector

• Network - if syncing to the upstream network 
connection

Refer to MG 9000 Configuration Management, 
NN10096-511.

16 Remove the NE 
from the SN06.2 
OMC collection list.

Once the DCC cards are at SN07, no OMs can be 
collected until the NE is imported to the SN07 Subnet 
View. Refer to the “Configuring OM Collector software” in 
MG 9000 Performance Management, NN10140-711 to 
remove the NE from the SN06.2 OMC collection list. The 
NE OM Collection checkbox must be checked in the 
MG 9000 Provisioning View which is accessed from the 
Subnet View Configuration menu for OM Collection to be 
enabled for an NE.

MG 9000 Manager and MG 9000 SN06.2 to SN07 upgrade checklist (two-server)

Activity Procedure √
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17 Create patched 
images of all 
MG 9000 loads

1. After the MG 9000 cards have been upgraded to 
SN07 and all other MG 9000 Manager workstations 
have been upgraded to SN07, perform the following 
procedure to image the network element (NE) cards 
for use in upgrading the cards in other NEs.

Note 1: Perform the following steps after the 
following conditions are met:

• the NPM is at SN07

• the suite of MG 9000 Manager servers are 
running SSPFS07, with both SN06.x and SN07 
MG 9000 Managers are resident

• the old SN06.x MG 9000 Manager is not in control 
of the MG 9000 devices which are running SN07

Note 2: The following steps will create patched 
images of all MG 9000 loads. This will be 
accomplished by upgrading, patching, and then 
imaging two MG 9000s (one DCC-OC3 MG 9000 and 
one DCC-DS1-IMA MG 9000). Ensure the NEs 
selected include all MG 9000 intelligent card types in 
the office. 

First the user will upgrade all the intelligent cards on 
a DCC-OC3 MG 9000 using the latest available PI 
loads. After the upgrade, the user will patch all 
intelligent cards on the DCC-OC3 MG 9000 with any 
available patches that were not included on the PI 
load tape. After patching is complete, the user will 
take an image of the DCC-OC3 MG 9000 using the 
NPM.

Next, the user will upgrade a DCC-IMA MG 9000 
using the PI loads just created. After the upgrade, the 
user will apply any available patches for any 
remaining intelligent card types (including the 
DCC-DS1-IMA) that were not patched during the 
DCC-OC3 MG 9000 upgrade. After patching is 
complete, the user will take an image of the 
DCC-DS1-IMA MG 9000 using the NPM.

MG 9000 Manager and MG 9000 SN06.2 to SN07 upgrade checklist (two-server)

Activity Procedure √
Upgrading the MG 9000
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17 Create patched 
images of all 
MG 9000 loads 
(contd)

a. Use the following to determine the next step.

• if there were additional patches added to the 
pre-patched image loadfile, go to step d

• if there were no additional patches added to 
the pre-patched image loadfile, go to step b

b. Apply remaining SN07 patches to all cards on this 
NE with DCC OC3 cards.

c. Import this NE with DCC OC3 cards to the SN07 
MG 9000 Manager.

Note: Make sure an audit is not in progress and 
is not scheduled for this NE. 

Go to the SN07 Subnet View and click on the 
MG9000 menu and click on Import NE.

From the Import From XML File window, select 
the SN06.x import path 

/data/mg9kem/persistdata/xml/SN06/<ne_nu
mber> for SN06, 

or

/data/mg9kem/persistdata/xml/SN06_2/<ne_n
umber> for SN06_2

which is to be upgraded. 

Select Import. This will import and convert all the 
SN06.2 data which was previously exported. The 
NE icon will be created and a discovery/recovery 
process is started.

Refer to Performing an Import NE on page 69.

d. Take an image of the inactive cards on this NE 
with DCC OC3 cards. Refer to the “Performing a 
device image using the NPM” in ATM Solutions 
Upgrade, NN10261-450 or IP Solutions Upgrade, 
NN10344-450 for steps on performing a device 
image. Select SmartImage->MG9KDEVICES..

MG 9000 Manager and MG 9000 SN06.2 to SN07 upgrade checklist (two-server)

Activity Procedure √
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17 Create patched 
images of all 
MG 9000 loads 
(contd)

e. Upgrade one NE with DCC-DS1-IMA cards with 
the SN07 MG 9000 patched images just created 
in the previous step. Load all cards on this NE 
with the supplied image.

f. Import this NE with DCC DS1-IMA cards to the 
SN07 MG 9000 Manager.

Note: Make sure an audit is not in progress and 
is not scheduled for this NE. Observe the Audit 
Tasks tab in the Frame View.

Go to the SN07 Subnet View and click on the 
MG9000 menu and click on Import NE.

From the Import From XML File window, select 
the SN06.x import path 

/data/mg9kem/persistdata/xml/SN06/<ne_nu
mber> for SN06, 

or

/data/mg9kem/persistdata/xml/SN06_2/<ne_n
umber> for SN06_2

which is to be upgraded. 

Select Import. This will import and convert all the 
SN06.2 data which was previously exported. The 
NE icon will be created and a discovery/recovery 
process is started.

Refer to Performing an Import NE on page 69.

g. Apply the remaining patches to all cards on this 
NE with DCC DS1-IMA cards.

h. Take an image of the inactive cards on this NE 
with DCC DS1-IMA cards that were not imaged in 
step d above. Refer to the “Performing a device 
image using the NPM” in ATM Solutions 
Upgrade, NN10261-450 or IP Solutions Upgrade, 
NN10344-450 for steps on performing a device 
image. Select SmartImage->MG9KDEVICES.

i. Use the images created in the previous steps to 
upgrade all the of the cards on all the remaining 
NEs to be upgraded to SN07

MG 9000 Manager and MG 9000 SN06.2 to SN07 upgrade checklist (two-server)

Activity Procedure √
Upgrading the MG 9000
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18 Delete the NE 
which was just 
upgraded.

Go to the SN06.2 Subnet View. From the menu bar, select 
Configuration->Delete Node. Click on Apply. 

Refer to the “Deleting an MG 9000 network element” 
procedure in MG 9000 Configuration Management, 
NN10096-511.

19 Configure 
Enhanced ESA, if 
applicable (only 
applies to North 
America)

Go to the Switched Lines Services GUI and change the 
VMGs to support Enhanced ESA.

Refer to the “Provisioning ESA” procedure in MG 9000 
Configuration Management, NN10096-511.

Note: This is a safe stopping point.

After all NEs are at SN07 and there is no need to downgrade to SN06.2 proceed to the
next step: 

Note: If it is necessary to downgrade the MG 9000 and MG 9000 Manager, perform the
Downgrading the MG 9000 Manager from SN07 to SN06.x on page 73 procedure, 
otherwise proceed to the next step.

MG 9000 Manager and MG 9000 SN06.2 to SN07 upgrade checklist (two-server)

Activity Procedure √
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20 Run the pkgrm 
script on each 
server (master 
server and mid-tier 
server) to stop the 
SN06.2 server 
application and 
uninstall the server 
application. 

Note: Once the 
packages have 
been removed, it 
will not be possible 
to downgrade 
without 
re-importing a 
saved data image 
and a resulting loss 
of service.

1. Perform the following steps:

a. Login as root.

b. To stop the SN06.2 mid-tier server, type
> servstop MG9KMIDTIER_06_2 

c. To stop the SN06.2 master server, type
> servstop MG9KSERVER_06_2 

d. To stop the SN06.2 OM collector, type
> servstop MG9KOMC_06_2 

e. To remove the master server SN06.2 software, 
type
> pkgrm NTmg9ks62 

To continue, respond to the prompt with Y.

f. To remove the mid-tier server SN06 software, 
type
> pkgrm NTmg9km62 

To continue, respond to the prompt with Y.

g. To remove the OM collector SN06.2 software, 
type
> pkgrm NTomclt62 

To continue, respond to the prompt with Y.

Note: Proceed to the next step only after the one night process (ONP) is 
complete.

21 Clone the image of 
the upgraded node 
onto the other node

Perform procedure “Cloning the image of one node in a 
cluster to the other node” in ATM Solutions Upgrades, 
NN10261-450 or IP Solutions Upgrades, NN10344-450. 

Note: After step 21 is performed, the MG 9000s cannot be downgraded to 
SN06 without service data loss.

22 After each node is 
upgraded to SN07, 
FTP the ESA data 
to database.

To ensure ESA data is correct, FTP the ESA data to the 
database.

MG 9000 Manager and MG 9000 SN06.2 to SN07 upgrade checklist (two-server)

Activity Procedure √
Upgrading the MG 9000
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23 Clean up old data 
in the NPM 
database.

Perform the procedure “Cleaning up old data in the NPM 
database” in ATM Solutions Upgrades, NN10261-450 or 
IP Solutions Upgrades, NN10344-450. 

24 This procedure is complete.

MG 9000 Manager and MG 9000 SN06.2 to SN07 upgrade checklist (two-server)

Activity Procedure √
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Upgrading the MG 9000 Manager

The following procedures are included in this section:

• Upgrading MG 9000 Manager software on page 40

• Importing MG 9000 Manager data on page 69

• Exporting MG 9000 Manager data on page 71 

• Patching MG 9000 Manager software on page 87

• Downgrading the MG 9000 Manager from SN07 to SN06.x on 
page 73

• Upgrading the MG 9000 Manager software to a maintenance 
release on page 76
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Upgrading MG 9000 Manager software

When to use this procedure
Use these procedures for upgrading the server, mid-tier, and client 
portions of the MG 9000 Manager. A procedure for upgrading software 
on a PC client is also provided. 

Note: The software must be installed in the order presented in 
Upgrading MG 9000 Manager software from SN06.x to SN07 on 
page 41. 

The following procedures are included in this section:

• Upgrading MG 9000 Manager software from SN06.x to SN07

• Upgrading the MG 9000 Manager server

• Upgrading the MG 9000 Manager mid-tier

• Installing the MG 9000 Manager Sun client software

• Uninstalling the MG 9000 Manager Sun client software

• Installing the MG 9000 Manager Windows PC client software

• Removing an MG 9000 Manager JWS application from cache

Prerequisites
There are no prerequisites.
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Action

Upgrading MG 9000 Manager software from SN06.x to SN07

At the MG 9000 Manager

1 Stop the SN06.x MG 9000 client applications.

2 Use the information in the following table to determine the next 
step.

3 Stop the SN06.x mid-tier server application by typing 

for SN06

> /opt/nortel/mg9kmtr_06/bin/mg9kmidtier stop

for SN06.2 

> servstop MG9KMIDTIER_06_2

4 Stop the SN06.x server application 

for SN06

> /opt/nortel/mg9ksrv_06_2/bin/mg9kserver stop

for SN06.2

> servstop MG9KSERVER_06_2

Note: Before moving to the next step to upgrade the SSPFS 
platform, perform a backup of the SSPFS file system using the 
“Full backup of file system procedure” in ATM/IP Security and 
Administration, NN10402-600.

5 To verify the MG 9000 mid-tier and server applications have 
stopped, type

> servquery -status all 

6 Stop the OM Collector by typing

for SN06

> /opt/nortel/OMCltr_06/bin/OMCollector stop 

If the MG 9000 Manager 
software to be upgraded 
runs on 

Do

an N240 cluster (two-server) 
configuration

step 9

a t1400/N240 simplex (one-server) 
configuration

step 3
Upgrading the MG 9000
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for SN06

> servstop MG9KOMC_06_2 

7 Use the information in the following table to determine the next 
step.

8 Upgrade both the mid-tier server and the master server to the 
SN07 SSPFS platform. 

Note 1: Ensure the master server is restarted before mid-tier 
server.

Note 2: If the mid-tier server comes up before the master 
server, it will go through a restart loop until the master server 
comes up.

Details about upgrading the SSPFS platform are provided in 
procedure “Upgrading SSPFS software” in ATM Solutions 
Upgrades, NN10261-450 or IP Solutions Upgrades, 
NN10344-450.

9 Install any patches for SSPFS using the NPM.

Note: If this is an N240 cluster configuration, install the 
patches using the NPM on the inactive side.

10 Verify that the DB Host IP address is correct. Perform the 
following steps:

a Change the directory by typing

for SN06

cd /opt/nortel/mg9ksrv_06/bin 

for SN06.2

cd /opt/nortel/mg9ksrv_06_2/bin 

If the MG 9000 Manager 
software to be upgraded 
runs on 

Do

an N240 cluster (two-server) 
configuration, the SSPFS has 
already been upgraded

step 9

a t1400/N240 simplex (one-server) 
configuration

step 8
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b Enter the following command:

./mg9kserver config 

The system responds with

WARNING: Server is currently running, its 
recommended that the server be shutdown 
before making any configuration setting 
changes.
Main Configuration Menu

1) Change Distribution Policy
2) Change SESM IP Address
3) Change Oracle IP Address
4) Change Debug Level for logs
5) Change Persistence settings
6) Change ESA data download settings
7) Change EM Factory Sleep
8) Display current settings
9) Exit from Main Menu

Please make a selection => 

c Enter 6 (for SN06) or 8 (for SN06.2) to display current setting.

The system responds with the following:

 CURRENT SETTINGS
Package Name :NTmg9ks62
Version  :NTMG9KS_6_2_481_0
Server Mode :MASTER
Master Server IP Address :47.xxx.xx.98
SESM IP Address :47.xxx.xx.66
Oracle IP Address :47.xxx.xx.66
Maintenance Release Upgrade :No
Initialize Database :YES
Security Authentication Host :47.xxx.xx.98
ESA data download time :1:30 AM
ESA data device name :/SFDEV
ESA data file name :ESA_SYSTEM_SD$XML

d Enter 7 (for SN06) or 9 (for SN06.2) to exit from the 
Configuration menu.

e Verify that the Oracle IP address is correct
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f Enter the following command by typing

# echo $DB_HOST 

The system responds with DB Host IP address

# 47.xx.xx.66

This IP address should match the Oracle IP address above.

11 The next step is determined by the information in the following 
table.

12 To change the DB Host IP address, perform the following steps:

a Enter the following command

#./mg9kserver config 

The system responds with

Main Configuration Menu

1) Change Distribution Policy
2) Change SESM IP Address
3) Change Oracle IP Address
4) Change Debug Level for logs
5) Change Persistence settings
6) Change ESA data download settings
7) Change EM Factory Sleep
8) Display current settings
9) Exit from Main Menu

Please make a selection=>

If the DB Host IP address is Do

correct Step 13

not correct Step 12
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b To change the Oracle IP address, enter 3.

The system responds with the following:

Oracle IP Address Configuration Menu

1) Enter new Oracle IP Address
2) Exit to Main Menu

Please make a selection [Current: 
47.xxx.xx.66 ] => 1

WARNING: Changing the Database Host will 
effect all applications! Improper database 
configuration will result in loss of service 
and possible loss of data. Applications which 
use the database server must be shutdown 
before continuing.

Oracle Server is currently: 47.xxx.xx.66

Do You Want To Change the Oracle Server, Type 
"yes" or "no": 

c To change the Oracle server, type

> Yes 

d Enter the IP Address of the Oracle Server

> 47.xxx.xx.100  

The system responds with the following:

Database change successful 

Please quit this shell and login again to 
inherit the new settings. 

Applications need to be reconfigured with the 
new database host.

e The MG 9000 mid-tier GUI banner now displays the 
CM_CLLI. This needs to be configured by performing the 
following steps while logged into the MG 9000 master server. 
Once this is complete, log into the MG 9000 mid-tier and 
perform the same steps. If the MG 9000 master server and 
mid-tier reside on the same IP, you only need to perform this 
once.

i Log in as root by typing

$ su - root
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The system responds with the following:

Password:
<enter the root password>

The system responds with the following:

# cli
Command Line Interface
 1 - View
 2 - Configuration
 3 - Other

 X - exit

ii Enter 2 to access the Configuration menu.

The system responds with the following:

Configuration
 1 - NTP Configuration
 2 - Apache Proxy Configuration
 3 - DCE Configuration
 4 - OAMP Application Configuration
 5 - CORBA Configuration
 6 - IP Configuration
 7 - DNS Configuration
 8 - Syslog Configuration
 9 - Database Configuration
10 - NFS Configuration
11 - Bootp Configuration
12 - Restricted Shell Configuration
13 - Security Services Configuration
14 - Login Session
15 - Location Configuration
16 - Cluster Configuration
17 - Succession Element Configuration
18 - snmp_poller (SNMP Poller 
Configuration)

 X - exit

iii Enter 4 to access the OAMP Application Configuration 
menu.

The system responds with the following:

OAMP Application Configuration
 1 - sdm_conf (Configure SDM IP Address and 
User)
 2 - sdm_unconf (Unconfigure SDM IP Address 
and User)
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 3 - cmClli_conf (Configure CM_CLLI 
Address)
 4 - cmClli_unconf (Unconfigure CM_CLLI IP 
Address)
 5 - cm_conf (Configure CM IP Address)
 6 - cm_unconf (Unconfigure CM IP Address)

 X - exit

iv Enter 3 to configure the CM CLLI address.

The system responds with the following:

=== Executing "cmClli_conf"
Enter CM_CLLI:  <site CM_CLLI>
CM CLLI :         <site CM_CLLI>

v Enter "ok" to accept current settings.

 ok

Processing values....

CM_CLLI Configured
Please perform a logout and login so your 
shell will reflect CLLI environment 
settings

=== "cmClli_conf" completed successfully

vi Quit this shell and login again to inherit the new settings.

13 Install the SN07 master server application by performing the 
procedure Upgrading the MG 9000 Manager master server on 
page 52. 

14 Use the following table to determine the next step.

15 Start the SN07 master server application by typing

> /opt/nortel/mg9ksrv_07/bin/mg9kserver start

Note: Messages may appear indicating that a 
“<file_name>_patch failed to stay up.” These messages can 
be ignored.

If the server being upgrade 
is

Do

an N240 cluster configuration step 17

an N240 one-server or t1400 
configuration

step 15
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16 Ensure the SN06.2 server application is running by typing

for SN06

> /opt/nortel/mg9ksrv_06/bin/mg9kserver status

Note: If the SN06.2 server application is not running, type

> /opt/nortel/mg9ksrv_06/bin/mg9kserver start

for SN06.2

> servquery -status all 

and verify the following is output

MG9KSERVER_06_2 RUNNING

Note: If the SN06.2 server application is not running, type

> servstart MG9KSERVER_06_2

17 Install the SN07 mid-tier server application by performing the 
procedure Upgrading the MG 9000 Manager mid-tier server on 
page 55. 

18 Use the following table to determine the next step.

19 Start the SN07 mid-tier server application by typing

> /opt/nortel/mg9kmtr_07/bin/mg9kmidtier start

Note: Messages may appear indicating that a 
“<file_name>_patch failed to stay up.” These messages can 
be ignored.

If the server being upgrade 
is

Do

an N240 cluster configuration step 21

an N240 one-server or t1400 
configuration

step 19
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20 Ensure the SN06.x mid-tier application is running by typing

for SN06

> /opt/nortel/mg9kmtr_06/bin/mg9kmidtier 
status 

Note: If the SN06 mid-tier application is not running, type

> /opt/nortel/mg9kmtr_06/bin/mg9kmidtier start

for SN06.2

> servquery -status all 

and verify the following is output

MG9KMIDTIER_06_2 RUNNING

Note: If the SN06.2 mid-tier application is not running, type

> servstart MG9KMIDTIER_06_2

21 Install the SN07 performance collector and formatter (PCF) 
software. Refer to MG 9000 Performance Management, 
NN10140-711 for the PCF software installation procedure. 
Configure the PCF software after the installation is complete. 

If this is an N240 cluster configuration, install the software on the 
inactive side.

22 Apply any MG 9000 Manager software patches. Refer to 
Patching MG 9000 Manager software on page 87.

23 Use the following table to determine the next step.

24 Patch the inactive node of the cluster by performing the 
procedure “Patching the inactive side of a cluster during an 
upgrade” in ATM Solutions Upgrades, NN10261-450 or IP 
Solutions Upgrades, NN10344-450.

25 Telnet to the cluster IP address, login to the active unit and 
perform a failover of the system by typing

> init 6 

26 Perform the procedure “Cloning the image of one node in a 
cluster to the other node” in ATM Solutions Upgrades, 
NN10261-450 or IP Solutions Upgrades, NN10344-450.

If the server being upgrade 
is

Do

an N240 cluster configuration step 24

an N240 one-server or t1400 
configuration

step 27
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27 Install the SN07 GUI client application by performing the 
installation procedure based on the platform type used for the 
client, PC or Sun workstation. Refer to the Installing the 
MG 9000 Sun client software on page 66 or Installing the MG 
9000 Manager Windows PC client software on page 64 
procedure.

28 Provision a userid with appropriate privileges for the upgrade 
process. Add a new user to group “succssn” and “emsadm.” To 
allow access to the GUI, from the mid-tier server type

> useradd -g succssn -G emsadm [userid] 

where emsadm is the privilege to be assigned to the userid. 
Refer to MG 9000 Administration and Security for details. 

29 To enter the password for this userid, type 

>passwd [userid] 

Note: The password must be entered twice.

30 Start any SN07 3rd party application(s), especially those using 
the OSS alarm interface.

31 Configure the network elements with the OM collector. Refer to 
the “Installing OM Collector software” in MG 9000 Performance 
Management, NN10140-711.

32 Start the SN07 OM Collector by typing

> servstart MG9KOMC_07 

33 Start the OM Collector by typing

for SN06

> /opt/nortel/OMCltr_06/bin/OMCollector start 

for SN06.2

> servstart MG9KOMC_06_2 

34 Restart the master server application by typing

for SN06

> /opt/nortel/mg9ksrv_06/bin/mg9kserver start 

for SN06.2

> servstart MG9KSERVER_06_2 
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35 Restart the mid-tier server application by typing

for SN06

 /opt/nortel/mg9kmtr_06/bin/mg9kmidtier start 

for SN06.2

> servstart MG9KMIDTIER_06_2 

36 Start the SN06.x GUI client application.

37 Start the SN07 GUI client application.

Note 1: Two Subnet Views should appear at the GUI Client. 
One Subnet View for SN06.x and one Subnet View for SN07. 
All NEs should still be in the SN06.x Subnet View.

Note 2: A discover/recover and audit of all the SN06.x NEs 
should occur in the SN06.x Subnet View.

38 This procedure is complete. 

If this is a simplex upgrade, return to step 1a of the MG 9000 
Manager and MG 9000 SN06.x to SN07 upgrade checklist 
(one-server) on page 13 and continue with the SN06.x to SN07 
upgrade process. 

If this is a two-server upgrade, return to step 3h of the MG 9000 
Manager and MG 9000 SN06.2 to SN07 upgrade checklist 
(two-server) on page 26 and continue with the SN06.2 to SN07 
upgrade process.
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Upgrading the MG 9000 Manager master server

At the workstation dedicated as the master server

1 Login as root (superuser) and insert the Succession MG 9000 
Manager software CD into the CD-ROM drive. This server is also 
running the OpenOrb NamingService.

Note: If this is an N240 cluster configuration, install the 
software on the inactive side.

2 List the available files on the Nortel Networks load disk. To list 
the files, change directory to the CD-ROM drive and list the 
contents by typing

> cd /cdrom/cdrom0 

> ls 

The system responds with the following example output:

# cd /cdrom/cdrom0 
# ls 
BWTool.exe NTMG9KS_7_31_0.PKG 
NTMG9KM_7_31_0.PKG NTOMCLTR_7_31_0.PKG

3 At the prompt (#), use pkgadd to install the server portion 
(NTmg9ks07.pkg) of the software. To directly install the software 
from the CD, enter the following command:

# pkgadd -d /cdrom/cdrom0/<mgemserver package> 

where <mgemserver package> is the MG 9000 Manager server 
package name, for example NTMG9KS_7_31_0.PKG

The system responds with the following:

The following packages are available:

 1 NTmg9ks07 Succession MG 9000 Manager Server
(sparc) 7.44

Select package (s) you wish to process (or ‘all’ 
to process all packages). (default: all) 
[?,??,q]:
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4 Enter “1” and press return to begin the server installation 
process. 

The system responds with the following: 

Processing package instance <NTmg9ks07> from 
</NTmg9ks07.pkg>

Succession MG 9000 Manager Server (sparc) 7.44

Copyright (c) 1998-2003 Nortel Networks
All Rights Reserved

This product is protected by copyright and 
distributed under licenses restricting copying, 
distribution and decompilation. 

## Executing checkinstall script. 
Using as the package base directory. 
## Processing package information. 
## Processing system information. 

135 package pathnames are already properly 
installed. 
## Verifying disk space requirements. 
## Checking for conflicts with packages already 
installed. 
## Checking for setuid/setgid programs. 

This package contains scripts which will be 
executed with super-user permission during the 
process of installing this package. 

Do you want to continue with the installation of 
<NTmg9ks07> [y,n,?] 

5 Enter Y to continue with the installation.

Note: Verify that the “Installation of <NTmg9ks07> was 
successful.” If there are any errors please contact your next 
level of support.

6 Eject the CD-ROM by typing

# eject cdrom0 

7 Obtain the IP address or hostname of the current master server 
by typing

# hostname
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8 This procedure is complete. If this activity is part of an MG 9000 
Manager upgrade, return to step 14 in procedure Upgrading MG 
9000 Manager software from SN06.x to SN07 to continue with 
the upgrade process.
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Upgrading the MG 9000 Manager mid-tier server

At the workstation dedicated as mid-tier server

1 Login as root (superuser) and insert the CD containing the 
Succession MG 9000 Manager software into the CD-ROM drive.

Note: If this is an N240 cluster configuration, install the 
software on the inactive side.

2 At the prompt (#) use pkgadd to install the mid-tier portion 
(NTmg9km07.pkg) of the software. If you are directly installing 
from the CD-ROM use the following command to read the 
CD-ROM, and list the contents to read the release number:

# cd /cdrom/cdrom0/ 

# ls 

# pkgadd -d /cdrom/cdrom0/NTmg9km_7_xx_0.pkg

where xx is the release number.

The system responds with the following information.

The following packages are available:
1 NTmg9km07 Succession MG 9000 Manager Midtier 
Server
                   (sparc) 7.44

Select package(s) you wish to process (or 'all' 
to process all packages). (default: all) 
[?,??,q]: all

3 Enter “1” and press return to begin the server installation 
process. 

The system responds as follows:

Executing checkinstall script.
Using </opt> as the package base directory.
Processing package information.
Processing system information.
1 package pathname is already properly 
installed.

Note: If a message appears with a confirmation prompt to 
overwriting conflicting files, respond Y. If existing files are not 
overwritten, the MG 9000 Manager mid-tier server upgrade 
cannot continue.
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Verifying disk space requirements.
Checking for conflicts with packages already 
installed.Checking for setuid/setgid programs.

This package contains scripts which will be 
executed with super-user permission during the 
process of installing this package.

Do you want to continue with the installation of 
<NTmg9km07> [y,n,?] 

# Y 

Note: Verify that “Installation of <NTmg9km_7_xx_0> was 
successful.” If there are any errors please contact your next 
level of support.

4 The installation continues automatically and installs all the 
mid-tier server files in /opt/nortel/mg9kmtr_07 subdirectory as 
noted in the system response.

Installing Succession MG 9000 Manager Midtier 
Server as <NTmg9km07>

## Installing part 1 of 1.
.
.
.
Configuring system, please wait ...

Installation of <NTmg9km07> was successful.

After the installation is compete, a message appears reporting 
that the installation was successful.

5 This procedure is complete. If this activity is part of an MG 9000 
Manager upgrade, return to step 18 of procedure Upgrading MG 
9000 Manager software from SN06.x to SN07 to continue with 
the upgrade process.
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Configuring the MG 9000 Manager master server software

At the workstation dedicated as the MG 9000 Manager master 
server

1 Collect previous configuration data before proceeding. To 
display previous configuration data, type

> /opt/nortel/mg9ksrv_06_2/bin/mg9kserver 
config 

The system responds with the following:

WARNING: Server is currently running, its 
recommended that the server be shutdown before 
making any configuration setting changes.
Main Configuration Menu

1) Change Distribution Policy
2) Change SESM IP Address
3) Change Oracle IP Address
4) Change Debug Level for logs
5) Change Persistence settings
6) Change ESA data download settings
7) Change EM Factory Sleep
8) Display current settings
9) Exit from Main Menu

2 Enter 8 to display current settings.

The system responds with the following example output:

CURRENT SETTINGS
Package Name                   :NTmg9ks62
Version                        :NTMG9KS_6_2_481_0
Server Mode                    :MASTER
Master Server IP Address       :47.xxx.xx.134
SESM IP Address                :47.xxx.xx.137
Oracle IP Address              :47.xx.xx.137
Maintenace Release Upgrade     :NO
Initialize Database            :YES
Security Authentication Host   :47.xx.xx.134
ESA data download time         :1:30 AM
ESA data device name :/SFDEV
ESA data file name :ESA_SYSTEM_SD$XML

3 Exit the tool by entering 8 (for SN06) or 9 (for SN06.2). 

4 To configure the master server, type

> /opt/nortel/mg9ksrv_07/bin/mg9kconfig.sh 
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Note: The database for SN07 is not created until the server 
is restarted.

5 The system responds with the following

Please enter the IP Address or hostname of CS2M 
server?
Press the enter key to accept the default?
Default: [] =>

Note: Only enter a Hostname if DNS is properly configured. 
Nortel recommends using IP addresses only. 

6 Enter the IP address for the CS2M server or select the default 
address in response to the following:

Please enter the IP Address or hostname of the 
CS2M server? Press the enter key to accept the 
default ? 
Default: [] => x.x.x.x

# <CS2M server IP address> 

7 Enter the IP address where the Oracle server is being hosted in 
response to the following.

Please enter the IP Address or hostname of the 
Oracle host server? 
Press the enter key to accept the default ? 
Default: [47.xxx.xx.220] =>

Note: Only enter a Hostname if DNS is properly configured. 
Nortel recommends using IP addresses only. This information 
will be needed when configuring the mid-tier server.

This is usually the same IP address as the CS2M server, unless 
a dedicated Oracle server is being used, which requires a 
different IP address.

# <Oracle IP address> 

Note: Only enter a Hostname if DNS is properly configured. 
Nortel recommends using IP addresses only.

8 Enter the IP address of the Security Authentication Host in 
response to the following:

Note: The default IP is the MG 9000 mid-tier server IP 
address.

Please enter the IP address or hostname of the 
Authentication server? 
Press the enter key to accept the default ? 
Default: [47.xxx.xx.235] => 
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This is usually the same IP address as the MG 9000 mid-tier 
server IP address. 

9 Enter the IP address or Hostname of the server where image 
files are stored.

Please enter the IP address or hostname of the 
server that will be used to store load images.

NOTE: The FTP server must have over write 
privileges.

Press the enter key to accept the default ? 
Default: [x.x.x.x] =>

This is typically the SDM address. It must have over write 
privileges. Communication to the server is verified.

10 Enter yes if Integrated EMS (IEMS) is to be the Northbound 
interface for Logs.

Please enter yes if you want IEMS to be the 
Northbound interface for Logs? Press the enter 
key to accept the default (y/n)? 
Default: [y] =>

Note: Answering Y to this question means the syslog output 
of the master server has already been set to IEMS using the 
command line interface.

11 Enter the User ID that is used to FTP images to the FTP server 
entered in the previous step.

Enter the user id that will be used to ftp Images 
to the Image server. 

Press the enter key to accept the default ?
Default: [] => 

12 Enter the User ID and password to the Image server. This must 
have over write privileges.

Enter the user id that will be used to ftp Images 
to the Image server. 

Press the enter key to accept the default?
Default: [] => xxxx
Enter Password: xxxxxx
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13 Enter the directory where the images will be placed for each type 
of card.

Enter the directory that the image will be 
placed in for the following cards:

SCI: Press the enter key to accept the default ? 
Default: [/swd/mg9k] =>

SCO: Press the enter key to accept the default ? 
Default: [/swd/mg9k] =>

ITP: Press the enter key to accept the default ? 
Default: [/swd/mg9k] =>

ABI: Press the enter key to accept the default ? 
Default: [/swd/mg9k] =>

DS1: Press the enter key to accept the default ? 
Default: [/swd/mg9k] =>

14 Verify the system response.

**********************************************
Setup Server As : Master
Master Server IP Address : 47.xxx.xx.207
CS2M IP Address: 47.xxx.xx.220
Security Authentication Host : 47.xxx.xx.220
Get Northbound logs from IEMS : y
Oracle IP Address : 47.xxx.xx.8
Image Server : 47.xxx.xx.207
Image Server User ID : maint
SuperCore IMA Image Directory : /swd/mg9k
SuperCore OC3 Image Directory : /swd/mg9k
ITP Image Directory : /swd/mg9k
ITX Image Directory : /swd/mg9k
ABI Image Directory : /swd/mg9k
DS1 Image Directory : /swd/mg9k
**********************************************
Is the above information correct?
Press the enter key to accept the default (y/n)?
Default : [n] => y

15 Start the MG 9000 Manager server application. To start the 
server, type

> servstart MG9KSERVER_07 

16 For additional help on available options, execute the following 
command.

# /opt/nortel/mg9ksrv_07/bin/mg9kserver help
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17 This procedure is complete.

If this is a simplex upgrade, return to step1b  of the MG 9000 
Manager and MG 9000 SN06.x to SN07 upgrade checklist 
(one-server) on page 13 and continue with the SN06.x to SN07 
upgrade process. 

If this is a two-server upgrade, return to step 3i of the MG 9000 
Manager and MG 9000 SN06.2 to SN07 upgrade checklist 
(two-server) on page 26 and continue with the SN06.2 to SN07 
upgrade process.
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Configuring the MG 9000 Manager mid-tier server software

At the workstation dedicated as the MG 9000 Manager mid-tier 
server

1 Collect the current configuration by typing

for SN06

# /opt/nortel/mg9kmtr_06/bin/mg9kmidtier config 

for SN06.2

# /opt/nortel/mg9kmtr_06_2/bin/mg9kmidtier 
config 

The system responds with the following.

WARNING: Server is currently running, its 
recommended that the server be shutdown before 
making any configuration setting changes.

Main Configuration Menu 

1) Change IP Address of Master Server
2) Enable / Disable SSL Connections
3) Change Debug Level for logs
4) Display current settings
5) Exit from Main Menu

2 Select 4 from the list to display the current settings.

The system responds with the following.

CURRENT SETTINGS 
Package Name                   :NTmg9km62
Version                        :NTMG9KM_6_2_481_0
Master Server IP Address       :106.40.34.134
SSL enabled                    :false
Security Type                  :PAM Security

3 To configure the mid-tier server, type

# /opt/nortel/mg9kmtr_07/bin/mg9kconfig.sh 

4 Enter the IP address or hostname of the master server obtained 
in step 7 of Upgrading the MG 9000 Manager master server 

Note: Only enter a Hostname if DNS is properly configured. 
Nortel recommends using IP addresses only. 

# <IP address of Master server> 

Press Return to continue.
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5 The system prompts you to make sure the information provided 
is accurate.

.

.

.

Is the above information correct? Press the 
enter key to accept the default (y/n)? Default: 
[n] =>

6 Enter Y and continue.

Configuring system, please wait ...
Set JNLP softlinks for NTmg9km07...

Configuration complete ...

7 Restart the MG 9000 Manager mid-tier application. To start the 
application, type

> servstart MG9KMIDTIER_07 

8 This procedure is complete.

If this is a simplex upgrade, return to step1e  of the MG 9000 
Manager and MG 9000 SN06.x to SN07 upgrade checklist 
(one-server) on page 13 and continue with the SN06.x to SN07 
upgrade process. 

If this is a two-server upgrade, return to step 3j of the MG 9000 
Manager and MG 9000 SN06.2 to SN07 upgrade checklist 
(two-server) on page 26 and continue with the SN06.2 to SN07 
upgrade process.
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MG 9000 Manager client configuration

Installing the MG 9000 Manager Windows PC client software

At the Windows PC client 

1 From a web browser, launch Succession OAM&P Applications 
Launch Point page at: 
http://<SN07 MG9KEM Midtier Server IP or hostname>. Click on 
Application Launcher.

The Application Launch Point window appears containing two 
links, one for SN06.x and one for SN07. Click on the SN07 
“MG9000 Element Manager” link. The Application Launch Point 
window appears. Click on the” MG9000 Element Manager” link. 
Enter the username and password in the login when prompted.

Note: When starting the MG 9000 Manager from a Microsoft 
Windows platform, Windows may ask for a Security Certificate 
Approval. Windows does not display the Security Certificate 
Approval window on top of all other open windows. It may 
become necessary to iconify all open windows to see the 
Security Certificate Approval window. The security settings in 
the browser determine if the user will be asked for certificate 
approval.
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2 Use the following figure and the information in the following table 
to determine the next step.

3 Select the link “JavaTM Web Start Install Guide” to visit “Client 
Software Installation” page.

4 Visit “Java 2 Runtime Environment Install Guide” under 
“Microsoft Windows” section for online documentation.

5 Visit “Java 2 Runtime Environment Software Download” under 
“Microsoft Windows” section to download Java Runtime 
Environment.

6 Save j2re-1_4_1_02-windows-i586-i.exe and execute the JRE 
software.

7 Follow the instructions in JRE software to install JRE 1.4.1_02

8 The PC client is setup to launch MG 9000 Manager SN07 client 
applications.

9 This procedure is complete.

If Java Web Start (JWS) 
software

Do

is already installed in the client 
machine

step 8

is not installed in the client 
machine, as evidenced by the 
preceding message

step 3
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Installing the MG 9000 Sun client software

At the client workstation

1 From a web browser, launch Succession OAM&P Applications 
Launch Point page at: 
http://<SN07 MG9KEM Midtier Server IP or hostname>. Click on 
Application Launcher.

The Application Launch Point window appears containing two 
links, one for SN06.x and one for SN07. Click on the SN07 
“MG9000 Element Manager” link. The following figure shows the 
Application Launch Point with the SN06.x and SN07 MG 9000 
Manager links. Enter the username and password in the login 
when prompted.

Note: The top link that appears in the launch point window is 
for the SN07 client, the bottom link is for the SN06 client.
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2 Use the following figure and the information in the following table 
to determine the next step.

3 Select the link “JavaTM Web Start Install Guide” to visit “Client 
Software Installation” page. 

4 Visit “Java 2 Runtime Environment Install Guide” under “Sun 
Solaris” section for online documentation.

5 Visit “Java 2 Runtime Environment Software Download” under 
“Sun Solaris” section to download Java Runtime Environment. 

6 Save j2re-1_4_1_02-solaris-sparc.sh to your home directory.

7 Change execute permissions

$ chmod +x j2re-1_4_1_02-solaris-sparc.sh 

8 Execute JRE, this will create a JRE subdirectory called 
j2re1.4.1_02 in your home directory. Remember the path of this 
directory as you will need this path later when configuring JWS.

$ ./ j2re-1_4_1_02-solaris-sparc.sh 

9 Follow the instructions in JRE software to install JRE 1.4.1_02

10 In your j2re1.4.1_02 subdirectory there is a zip file called 
javaws-1_2_0_02-solaris-sparc-i.zip. Copy this zip file to your 
home directory.

11 Install JWS by unzipping the zip file and executing “install.sh”.

$ unzip ./javaws-1_2_0_02-solaris-sparc-i.zip 

$ ./install.sh 

12 Accept the license agreement and enter the path to JRE from 
step 8.

13 Follow the remaining online directions.

If Java Web Start (JWS) 
software

Do

is already installed in the client 
machine

step 14

is not installed in the client 
machine, as evidenced by the 
preceding message

step 3
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14 The Sun Solaris client is now setup to launch MG9KEM SN07 
client applications.

15 Exit the browser and launch the browser again for settings to 
take effect.

16 This procedure is complete.

Removing an MG 9000 Manager JWS application from cache

At the MG 9000 Manager client PC

1 Access the Java Web Start Application Manager by selecting 
Start->Programs->Java Web Start. The Java Web Start 
Application Manager appears.

2 Select View->Downloaded Applications from the menu bar.

3 Select an MG 9000 Manager JWS application to be deleted.

4 Select Application->Remove Application from the menu bar.

5 This procedure is complete.

The following procedure is provided as an optional method for 
accessing a JWS application on a Sun workstation.

Accessing JWS application on a Sun workstation

At the client workstation

1 Change directory to where the Java Web Start application is 
installed and enter the following command

> cd <path/javaws> 

2 To launch the Java WebStart application manager, type

> javaws & 

3 Select View->Downloaded Applications from the menu bar.

4 This procedure is complete.
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Importing MG 9000 Manager data

Purpose of these procedures
These procedures provide the steps for importing MG 9000 Manager 
data in an upgrade scenario.

When to use these procedures
Use the procedures when it is necessary to import MG 9000 Manager 
XML data.

The Import NE command is used to import data during an upgrade. 

Note: An import NE can only be used on undiscovered NEs which 
have previously been exported. If the NE is provisioned, the Import 
command will not show the NE as able to import. The only NEs that 
will be listed in the window will be undiscovered or non-existent NEs. 
The Import can be used if rolling back to a previous software release.

Prerequisites
This procedure has no prerequisites. 

Action

Performing an Import NE

At the MG 9000 Manager

1 From the Subnet View, select MG9000->ImportNE from the 
menu bar. The Import from XML file window appears. The 
following figure shows the Import from XML file window.
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Import from XML file window

2 When upgrading from SN06 to SN07, click on the NE with path 
named /data/mg9kem/persistdata/xml/SN06/ <ne_number>.

When upgrading from SN06.2 to SN07, click on the NE with path 
named /data/mg9kem/persistdata/xml/SN06_2/ <ne_number>.

3 Click Import. The progress will be displayed in the Import details 
pane. Close the window. The Import NE will cause a discovery 
and an audit to run. Observe the NE icon in the Subnet View 
appears with a discovery arrow. When the discovery arrow 
disappears, the Import is complete.

4 This procedure is complete.
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Exporting MG 9000 Manager data

Purpose of these procedures
This procedures provides the steps for exporting MG 9000 Manager 
data in an upgrade scenario.

Note: The Export NE command is no longer available in SN07. This 
procedure is used to support software upgrades from SN06.X to 
SN07.

When to use these procedures
Use the procedures when it is necessary to export MG 9000 Manager 
XML data.

The Export NE command is used to export the customer’s data in 
preparation for an upgrade. The command writes out the customer’s 
MG 9000 Manager data into XML files that are used when upgrading 
the MG 9000 Manager and MG 9000.

Prerequisites
This procedure has no prerequisites. 

Action

Performing an Export NE

At the MG 9000 Manager

1 From the Subnet View, select MG9000->ExportNE from the 
menu bar. The NE Export to XML file window appears. The 
following figure shows the NE Export to XML file window.

Note: Perform this procedure after provisioning activities are 
complete.
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NE Export to XML file window

2 Click on the NE, click on Export, then wait for the message 
“Completed XML Export” appears in the window indicating the 
export action is complete before closing the window.

Note: Use the Export All button when performing an export in 
support of an MR release upgrade.

3 This procedure is complete.
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Downgrading the MG 9000 Manager from SN07 to SN06.x

When to use this procedure
When it is necessary to downgrade the MG 9000 Manager from SN07 
to SN06.x, perform this downgrade procedure. Before continuing, 
consider the following:

• Service impact - 

— During the time when the NEs have been downgraded to SN06.x 
and the active DCC card is still at SN07, the node is not being 
managed. Alarms are going to the SN06.x MG 9000 Manager 
but any alarms specific to SN07 MG 9000 card loads are being 
dropped. Also, during this time OM collection cannot be 
performed. The NE must be added back into the SN06.x OM 
collector before OMs can be collected again. Also, ESA 
downloads cannot be performed during this time. Once the 
MG 9000 cards are downgraded to SN06.x, ESA downloads can 
then be performed again.

— The MG 9000 Manager must be downgraded before 
downgrading the CS 2000 Management Tools.

• Roll back time - Refer to the Computing upgrade and downgrade 
times on page 5 table for the time estimated time required for a 
downgrade from SN07 to SN06.x.

Prerequisites
There are no prerequisites.

Action

Downgrading the MG 9000 Manager from SN07 to SN06.x

At the MG 9000 Manager server

1 If the XML file from the SN06.x export was deleted, put the 
backup copy of the SN06.x export on the Master Server at 
/data/mg9kem/persistdata/xml/SN06/<ne_number> for SN06 or 
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/data/mg9k3m/persistdata/xml/SN06.2/<ne_number> for 
SN06.2.

Note: This assumes the following:

• the SN06.x master server application is still running

• the SN06.x mid-tier application is still running

• the SN06.x Namespace (MGEMS06 for SN06 and 
MGEMS062 for SN06.2) and user id are still present on the 
Oracle database

2 Ensure that an audit is not being performed or is scheduled for 
this NE.

3 In the SN06.x Subnet View, select MG9000->Import NE from the 
menu bar. 

Note: This assumes that the NE has been previously deleted 
from the SN06.x Subnet View.

4 Select the SN06.x import path 
(/data/mg9kem/persistdata/xml/SN06/<ne_number> for SN06 
or /data/mg9kem/persistdata/xml/SN06.2/<ne_number> for 
SN06.2) which is to be downgraded and click on Import. 

All the SN06.x data which was previously exported will be 
imported. Any data added after the export is not necessarily 
maintained. The NE icon will be created and the 
discovery/recovery process is started. 

5 Go to the SN07 Subnet View and delete the NE which was just 
downgraded. This will remove the data from the SN07 
namespace and user id in the database for the NE downgraded.

6 At the SN06.x Subnet View, perform a card downgrade on all the 
cards on the NE to go back to their SN06.x version using the 
Downgrading the MG 9000 from SN07 to SN06.x on page 138 
procedure. The DCC card must be downgraded first followed by 
the ITX, ITP, and ABI (DS-512) and/or DS1.

Note: This is a safe stopping point.

After all network elements are at SN06.x

7 Run the pkgrm script on each server (mid-tier server and master 
server) to remove the SN07 package. This stops the SN07 
NN10048-461   (I)SN07   Standard 06.02 December, 2004



Nortel Networks Confidential75Copyright © 2004, Nortel Networks
server application. Uninstall the server application by performing 
the following steps:

a Login as root.

b To remove the master server SN07 software, type

> pkgrm NTmg9ks07 

The system responds with

The following package is currently installed: 
NTmg9ks07 Succession MG 9000 Manager Midtier 
Server 
(sparc) NTMG9KS_7_281_0 

Do you want to remove this package? 

> Y 

c To remove the mid-tier server SN07 software, type

> pkgrm NTmg9km07 

The system responds with

The following package is currently installed: 
NTmg9km07 Succession MG 9000 Manager Midtier 
Server
(sparc) NTMG9KM_7_281_0 

Do you want to remove this package? 

> Y 

d To remove the OM collector SN07 software, type

> pkgrm NTomcltr07 

The system responds with

The following package is currently installed: 
NTomcltr07 Succession MG 9000 Manager Midtier 
Server
(sparc) NTOMCLTR07 

Do you want to remove this package? 

> Y 

8 This procedure is complete.
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Upgrading the MG 9000 Manager software to a maintenance release

When to use this procedure
Use the following procedure when upgrading the MG 9000 Manager 
software to a maintenance release (MR).

When a maintenance release is made available to the customer, data 
on the MG 9000 Manager which is at the SN07 format, must be moved 
into the MR format to maintain provisioned data.

The MR process is different depending on whether you have a High 
Availability (HA)-Cluster or non Cluster setup. 

• non Cluster setup - a simplex configuration with a single N240 
server or two T1400’s configured to run the MG 9000 Manager 
software

• HA-Cluster setup - a duplex configuration with two N240 servers 
that share one cluster IP address

Use the MR process that applies to your MG 9000 Manager setup.

Prerequisites
There are no prerequisites.

Action
NN10048-461   (I)SN07   Standard 06.02 December, 2004



77Copyright © 2004, Nortel Networks Nortel Networks Confidential
Upgrading MG 9000 Manager software to a maintenance release in 
a non Cluster setup (simplex configuration)

At the MG 9000 Manager

1 Prior to proceeding with this MR upgrade procedure, perform a 
backup of the entire Oracle database. Refer to “Performing a 
data backup on a Sun server” in ATM Solutions Upgrades, 
NN10261-450 or IP Solutions Upgrades, NN10344-450.

2 Upgrade the hardware, if necessary. Ensure the connection from 
the MG 9000 Manager to the MG 9000 is up.

3 To stop the GUI clients, click on File->Exit from the GUI to exit.

4 Telnet into the server running the MG 9000 Manager mid-tier 
application and log in as root at the servers during the MR 
process. 

5 Stop the mid-tier server by typing

# servstop MG9KMIDTIER_07 

Process information will be displayed

Shutting MG 9K Midtier Server down ...
Midtier shutdown complete

6 Stop the Performance Collector and Formatter (PCF) OM 
collection application by typing

# servstop MG9KOMC_07 

Process information will be displayed

Shutting OM Collector down ...

OM Collector shutdown complete

7 Stop the master server by typing

# servstop MG9KSERVER_07 

Process information will be displayed

Shutting MG 9K Server down ...

Server shutdown complete

8 If required, upgrade to the MR Succession Solaris Platform 
Foundation Software (SSPFS) Platform software, if any. Refer to 
“Upgrading SSPFS Software” in ATM Solutions Upgrades, 
NN10261-450 or IP Solutions Upgrades, NN10344-450. Back 
up the MG 9000 file system and save all data in the 
/data/mg9kem/persistdata directory. This includes the SSPFS 
load on the servers running the MG 9000 Manager master and 
mid-tier applications.
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9 Remove the old MG 9000 Manager server package by typing

> pkgrm NTmg9ks07 

The following package is currently installed:
NTmg9ks07 Succession MG 9000 Manager Server

(sparc) NTMG9KS_07_11_0
Do you want to remove this package?

10 Install and start the MR release MG 9000 Manager server 
application and initialize the database by performing the 
following steps:

a Telnet into the server running the MG 9000 Manager server 
application and log in as root.

b Add in the MR server package from the CD-ROM by typing

> pkgadd -d 
/cdrom/cdrom0/<MG9K_MR_server_package_name>.
pkg 

The following packages are available:
1 NTmg9ks07 Succession MG 9000 Manager Server

(sparc) NTMG9KS_07_44_0
Select package(s) you wish to process (or 
‘all’ to process all packages). 
(default: all) [?,??,q]:1

c Change to the following directory

> /opt/nortel/mg9ksrv_07/bin 
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d Configure the MG 9000 Manager server by typing

> ./mg9kconfig.sh 

The system responds with the following message:

Setup has detected configuration settings 
from a previous installation.

********************************************
Setup Server As : MASTER
Master Server IP Address : 47.xxx.xx.207
SESM IP Address  : 47.xxx.xx.220
Security Authentication Host: 47.xxx.xx.220
Oracle IP Address  : 47.xxx.xx.8
Image Server : 47.xxx.xx.207
Image Server User ID : maint
SuperCore IMA Image Directory: /swd/mg9k
SuperCore OC3 Image Directory: /swd/mg9k
ITP Image Directory : /swd/mg9k
ITX Image Directory : /swd/mg9k
ABI Image Directory : /swd/mg9k
DS1 Image Directory : /swd/mg9k
********************************************
Is the above information correct?
Press the enter key to accept the default 
(y/n)?
Default:[n]=>y

11 Start the MR MG 9000 Manager server application by typing

> servstart MG9KSERVER_07 

12 Install and start the MR release mid-tier application by 
performing the following steps:

a Telnet into the server running the MG 9000 Manager mid-tier 
application and log in as root on the MG 9000 mid-tier server. 

b Remove the old mid-tier package by typing

> pkgrm NTmg9km07 

The following packages are available:
1 NTmg9km07 Succession MG 9000 Manager 

Midtier Server
(sparc) NTMG9KM_7_44_0

Do you want to remove this package? y
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c Add in the MR mid-tier package from the CD-ROM by typing 

> pkgadd -d 
/cdrom/cdrom0/<MG9K_MR_midtier_package_name>
.pkg 

The following packages are available:
1 NTmg9km07 Succession MG 9000 Manager 

Midtier Server
(sparc) NTMG9KM_7_44_0

Select package(s) you wish to process (or 
‘all’ to process all packages). 
(default: all) [?,??,q]:1

d Change to the following directory

> /opt/nortel/mg9kmtr_07/bin 

e Configure the mid-tier by typing

> ./mg9kconfig.sh 

Setup has detected configuration settings 
from a previous installation.
****************************************
Master Server IP Address : 47.142.84.210 
Security Authentication Host : 47.142.84.211 
********************************************

Is the above information correct? 
Press the enter key to accept the default 
(y/n)? 
Default: [n] => y

f Start the MR mid-tier application by typing

> servstart MG9KMIDTIER_07 
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13 Install and start the SN07 MR OM collection application on the 
server where the mid-tier application is running by performing 
the following:

a Remove the old SN07 OM collector package by typing 

> pkgrm NTomclt07 

The following packages are available:
1 NTomcltm07 Succession Operational 
Measurement Collector

(sparc) NTOMCLTR_7_441_0
Do you want to remove this package? y

b Add in the MR OM collector package from the CD-ROM by 
typing

> pkgadd -d 
/cdrom/cdrom0/<NTmg9k_MR_OM_collector_packag
e_name>.pkg 

The following packages are available:
1 NTomclt07 Succession Operational  

Measurement Collector
(sparc) NTOMCLTR_07_42_0

Select package(s) you wish to process (or 
‘all’ to process all packages). 
(default: all) [?,??,q]:1

c Start the MR OM collector by typing

> servstart MG9KOMC_07 

14 Install the new MR release GUI client. Refer to Installing the 
MG 9000 Sun client software on page 66 procedure for a Sun 
workstation, or to Installing the MG 9000 Manager Windows PC 
client software on page 64 procedure for a Windows PC.

15 Reconnect any SN07 third party application that retrieves 
alarms for delivery to Operations Support System (OSS) fault 
management systems.

16 This procedure is complete.
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Upgrading MG 9000 Manager software to a maintenance release in 
an HA-Cluster setup

At the MG 9000 Manager

1 Upgrade the hardware, if necessary. Ensure the connection from 
the MG 9000 Manager to the MG 9000 is up.

2 To stop the GUI clients, click on File->Exit from the GUI to exit.

3 Telnet into the active server through the cluster IP address and 
log in as root. 

All MR upgrades are performed on the standby node while the 
active node is providing service. After the standby node of the 
cluster is upgraded and configured, perform a failover so the 
standby node becomes active. After determining that both nodes 
are functional, the newly active node with the MR update can be 
cloned to the standby node. This will ensure both nodes or units 
of the cluster have the same data image.

4 Determine which of the cluster nodes is in standby so it can be 
upgraded with the MR.

5 Telnet to the cluster IP address, log in as root and type:

# bash

The cluster prompt changes showing the unit and the status of 
the unit.

mgem_ha_srv-unit0(active):/>

6 Remove the old MG 9000 Manager server application on 
standby unit by typing

> pkgrm NTmg9ks07 

The following package is currently installed:
NTmg9ks07 Succession MG 9000 Manager Server

(sparc) NTMG9KS_7_44_0
Do you want to remove this package? Y

7 Install the MR release on the standby unit for the MG 9000 
Manager server application by performing the following steps:
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a Add in the MG 9000 Manager server package from the 
CD-ROM by typing

> pkgadd -d 
/cdrom/cdrom0/<MG9K_MR_server_package_name>.
pkg 

The following packages are available:
1 NTmg9ks07 Succession MG 9000 Manager Server

(sparc) NTMG9KS_7_441_0
Select package(s) you wish to process (or 
‘all’ to process all packages). 
(default: all) [?,??,q]:1

b Configure the MG 9000 Manager server application by typing

> /opt/nortel/mg9ksrv_07/bin/mg9kconfig.sh 

The system responds with the following message:

********************************************
Setup Server As : MASTER
Master Server IP Address : 47.xxx.xx.207
SESM IP Address  : 47.xxx.xx.220
Security Authentication Host: 47.xxx.xx.220
Oracle IP Address  : 47.xxx.xx.8
Image Server : 47.xxx.xx.207
Image Server User ID : maint
SuperCore IMA Image Directory: /swd/mg9k
SuperCore OC3 Image Directory: /swd/mg9k
ITP Image Directory : /swd/mg9k
ITX Image Directory : /swd/mg9k
ABI Image Directory : /swd/mg9k
DS1 Image Directory : /swd/mg9k
********************************************
Is the above information correct?
Press the enter key to accept the default 
(y/n)?
Default:[n]=>y

8 Install the MR release MG 9000 Manager mid-tier server 
application on the standby unit by performing the following steps:
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a Remove the old mid-tier package by typing

> pkgrm NTmg9km07 

The following packages are available:
1 NTmg9km07 Succession MG 9000 Manager 

Midtier Server
(sparc) NTMG9KM_7_44_0

Do you want to remove this package? y

b Add in the MR mid-tier package from the CD-ROM by typing 

> pkgadd -d 
/cdrom/cdrom0/<MG9K_MR_midtier_package_name>
.pkg 

The following packages are available:
1 NTmg9km07 Succession MG 9000 Manager 

Midtier Server
(sparc) NTMG9KM_7_441_0

Select package(s) you wish to process (or 
‘all’ to process all packages). 
(default: all) [?,??,q]:1

c Configure the mid-tier by typing

> /opt/nortel/mg9ksrv_07/bin/mg9kconfig.sh 

Setup has detected configuration settings 
from a previous installation.
********************************************
Master Server IP Address : 47.xxx.xx.209
Security Authentication Host : 47.xxx.xx.208
********************************************

Is the above information correct? 
Press the enter key to accept the default 
(y/n)? 
Default: [n] => y

9 Install and start the SN07 MR OM collection application on the 
standby unit by performing the following:
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a Remove the old SN07 OM collector package by typing 

> pkgrm NTomclt07 

The following packages are available:
1 NTomcltm07 Succession Operational 
Measurement Collector

(sparc) NTOMCLTR_7_44_0
Do you want to remove this package? y

b Add in the MR OM collector package from the CD-ROM by 
typing

> pkgadd -d 
/cdrom/cdrom0/<NTmg9k_MR_OM_collector_packag
e_name>.pkg 

The following packages are available:
1 NTomclt07 Succession Operational  

Measurement Collector
(sparc) NTOMCLTR_7_441_0

Select package(s) you wish to process (or 
‘all’ to process all packages). 
(default: all) [?,??,q]:1

Make the standby unit to be active now by 
causing the old active unit to failover and 
switch states with the standby unit that has 
currently been upgraded.

To create a failover, telnet to the cluster IP address, login into 
active unit and type:

> swact

Note: The failover can take around 5 minutes or more

10 Install the new MR release GUI client. Refer to Installing the 
MG 9000 Sun client software on page 66 procedure for a Sun 
workstation, or to Installing the MG 9000 Manager Windows PC 
client software on page 64 procedure for a Windows PC. 
Connect the client by pointing to the virtual IP address of the 
cluster.

11 Verify the newly active unit recovers by typing the following 
command while logged into the cluster IP address

> servquery -status all

12 Launch the MG 9000 Manager client.

13 Reconnect any SN07 third party application that retrieves 
alarms for delivery to Operations Support System (OSS) fault 
management systems.
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14 Once it is determined that the newly active node with the MR 
update is fully functional, mirror the newly active node to the 
standby node so both nodes have the same image. Perform 
procedure “Cloning the image of one node in a cluster to the 
other node” in ATM Solutions Upgrades, NN10261-450 or IP 
Solutions Upgrades, NN10344-450. 

15 This procedure is complete.
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Patching MG 9000 Manager software

The MG 9000 Manager server, mid-tier, and OM Collector are patched 
using the Network Patching Manager (NPM) patching system. The user 
must restart the server, mid-tier, and OM Collector applications through 
the NPM following application or removal of patches. 

For information and procedures for patching the MG 9000 Manager 
software using the NPM, refer to the Succession Patching chapter in 
ATM Solutions Upgrades, NN10261-450 or IP Solutions Upgrades, 
NN10344-450.

The following logs are generated when the MG 9000 Manager server 
shuts down or starts:

• MGEM700 - The element manger server is starting.

• MGEM702 - The mid-tier server is now starting.

• MGEM703 - The mid-tier server is shutting down.

• OMC700 - The OM Collector process was started.

• OMC701 - The OM Collector process is shutting down. 
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Upgrading the MG 9000

This section provides a description of the upgrade process and the 
software upgrade tool in the MG 9000 Manager used to upgrade 
software in the cards in the MG 9000. The following procedures for 
upgrading the MG 9000 are included in this section: 

• Installing MG 9000 loads into the CS 2000 Core Manager from DAT 
tape on page 90 

• Installing MG 9000 loads into the CS 2000 Management Tools 
Manager from CDROM on page 92 

• Provisioning a floating IP address on page 94 

• information on the process and tools used to upgrade software in 
the MG 9000 cards 

— Upgrading software in MG 9000 cards on page 97 

— Software Upgrade View on page 99 

— Software upgrade errors and problem resolution on page 106 

— Upgrade Wizard overview on page 112 

• upgrade procedures by type 

— Card upgrade with user intervention on page 123 

— Card upgrade without user intervention on page 128 

— MG upgrades on page 132 

— Upgrading the MG 9000 from SN06.x to SN07 on page 135 

• Downgrading the MG 9000 from SN07 to SN06.x on page 138 

• Downloading software into the MTA card on page 141 

• Downloading software into the xDSL card on page 143 

• Upgrade history on page 145 

• Patching the MG 9000 on page 148 
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Installing MG 9000 loads into CS 2000 Core Mgr from DAT tape

Purpose of this procedure
This procedure describes how to install the MG 9000 software loads 
onto the CS 2000 Core Manager (SDM) from Digital Audio Tape (DAT) 
tape. 

When to use this procedure
This procedure is to be used when a Maintenance Non-computing Load 
(MNCL) software release or standard NCL is delivered to the customer 
site.

Prerequisites
When supporting an upgrade from SN06.x to SN07, ensure the SN06.x 
loads are currently in the SDM in the event there is a need to perform a 
software downgrade from SN07 to SN06.x.

Action

Installing MG 9000 loads into the CS 2000 Core Manager from DAT 
tape

At the CS 2000 Core Manager frame

1 Insert the DAT tape in slot 2 or slot 13 on the CS 2000 Core 
Manager.

At the CS 2000 Core Manager console or terminal window

2 Log in to the CS 2000 Core Manager as the root user.

AIX Version 4
(C)Copyrights by IBM and by others 1982, 1996.
login: root
root’s password: <password>

3 Enter the SDM maintenance level by typing

#sdmmtc 

4 Enter the Software Installation Menu level by typing

>swim 

The system responds with the SWIM level.

5 Enter the Apply level by typing

>apply 
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6 Retrieve the fileset from tape by typing

>source <dat_no> 

where dat_no is 0 or 1. Use 0 if the DAT is in slot 2 or 1 if the 
DAT tape is in slot 13.

7 Select the new MG 9000 software from the Apply menu by typing 

>select <fileset_no> 

where fileset_no is an integer value and represents the new 
MG 9000 software file set such as “4”

To select multiple or all file sets, the Select command should be 
executed for each file set before the Apply command is 
executed. As each file set is selected, its file set is highlighted on 
the MAP terminal screen.

Note: The load will be placed in the following directory: 
/swd/mg9k/.

8 Apply the file set to the CS 2000 Core Manager (SDM) by typing

>apply 

9 The MG 9000 software is now available to support software 
upgrades from the MG 9000 Manager.

10 Remove the DAT tape.

11 This procedure is complete.
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Installing MG 9000 loads into CS 2000 Core Mgr from CDROM

Purpose of this procedure
This procedure describes how to install the MG 9000 software loads 
onto the CS 2000 Core Manager (SDM) from CDROM. 

When to use this procedure
This procedure is to be used when a Maintenance Non-computing Load 
(MNCL) software release or standard NCL is delivered to the customer 
site.

Prerequisites
When supporting an upgrade from SN06.x to SN07, ensure the SN06.x 
loads are currently in the SDM in the event there is a need to perform a 
software downgrade from SN07 to SN06.x.

Action

Installing MG 9000 loads into the CS 2000 Management Tools 
Manager from CDROM

At the CS 2000 Management Tools Manager

1 Insert the CDROM into the CDROM tray. If the unit is a Netra 240 
in a cluster configuration, use the active Netra 240 unit. The 
active unit is identified by a lit USER LED on the front of the unit.

The CDROM label for the SAM21 Shelf Controller software 
includes the product code, MG9K0007, on the lower half of the 
label.

At the CS 2000 Management Tools console or terminal window

2 Log in and then use the su command to gain root privilege.

login: username
Password: <password>
Last login: Fri Jun 30 12:48:18 from <otherhost>
su - root
Password: <password>

3 Execute the platform_load_install.sh script by typing

# /opt/nortel/sspfs/Scripts/platform_load_inst
all.sh 
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The system responds with the following.

Welcome to the Platform Installation Tool 
Version 3.2
    
============================================== 
RPM INSTALLATION/REMOVAL
============================
1) Install RPM from CDROM 2) Install RPM from 

Disk
3) Uninstall RPM 4) Query all RPMs
                                               
OTHER
=========
C) Change Rotation Parameters P) View Rotation 

Parameters
V) MG9K Platform Version X) Exit
Installed

Please choose one of the following: 

4 To install the software type 1 and press the Return key.

The screen clears and the contents of the .rpm package are 
displayed.

Note: If the message There is no cd in the CDROM 
drive, please check drive is displayed, ensure that the 
CDROM is inserted in the tray for this unit.

5 To proceed with the software installation, type Y.

The software is extracted from the .rpm package. The .rpm 
package is transferred to the CS 2000 Core Manager.

6 Enter the root password for the CS 2000 Core Manager. The 
software is installed on the CS 2000 Core Manager.

7 Enter the Eject command to eject the CD from the CDROM 
drive.

# eject 

8 Log out of the CS 2000 Management Tools server.

9 Remove the CDROM.

10 This procedure is complete.
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Provisioning a floating IP address

Purpose of this procedure
The MG 9000 Manager assigns the floating IP address to the card 
being upgraded dynamically. The floating IP address is provisioned 
from the MG 9000 Manager as described in the following procedure. 
Provisioning a floating IP address should be performed during initial 
installation and commissioning. The floating IP address is persisted in 
the MG 9000 Manager data.

Note:  Before beginning, ensure you have the correct privileges to 
perform this procedure.

Contact your network administrator to obtain a new IP address when a 
new floating IP address must be provisioned.

When to use this procedure
This procedure is provided only if the need arises to change, correct, or 
add the floating IP address.

Prerequisites
There are no prerequisites. 

Action

Provisioning a floating IP address

At the MG 9000 Manager

1 Verify whether a floating IP address has already been 
provisioned at the MG 9000 Manager by selecting 
Services->Floating IP Address Manager from the menu bar of 
any Frame, Shelf, or Card View. This address must be in the 
same subnet as the MG 9000.

Note: If performing an upgrade from SN06.x to SN07, 
perform this step from the SN06.x MG 9000 Manager.

2 To provision a floating IP address in the MG 9000 Manager if 
necessary, perform the following steps:

a From any Frame, Shelf, or Card view select the menu 
Services. From within Services select Floating IP Address 
Manager, as shown in the following figure.
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Floating IP Address Manager accessed from Shelf View
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b Enter the IP address in the Floating IP Address Manager and 
select Apply. The address will be displayed under existing IP 
addresses. When finished, select Close. 

Floating IP Address Manager View

c If the floating IP address must be replaced, delete the entry 
first. To delete an entry select the entry, select the Delete 
check box, then press Apply. When finished select Close.

d If the floating IP address is correct, select Close.

3 This procedure is complete. If this is part of an upgrade, return 
to the upgrade checklist to continue with the upgrade process.
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Upgrading software in MG 9000 cards

This section provides an overview of upgrading software in MG 9000 
cards.

The MG 9000 Manager provides tools for upgrading software in 
MG 9000 cards to upgrade the software in the following intelligent cards 
in the MG 9000: 

• data control card (DCC)

— OC-3

— DS1-IMA

• Internet telephony extender (ITX) card 

• Internet telephony processor (ITP) card 

• DS-512 Access Bridging Interface (ABI) card 

• DS1 card (not used in UA-IP solution)

The following cards do not use the Software Upgrade Wizard. Instead, 
each card must have the software downloaded into it individually using 
the Software Download tool accessed from the card view for each card. 
There are software download procedures provided for these cards later 
in this document.

• metallic test access (MTA) card

• x digital subscriber line (xDSL) card

The software upgrade consists of the following four steps:

1. Configure - The configuration parameters are entered in a Card 
Upgrade Wizard or MG Upgrade Wizard described later.

2. Download - The MG 9000 is requested to download the software 
load to a card or cards based in the parameters configured in the 
previous step. The load is downloaded and stored in flash memory.

3. Apply - The software load is installed. A restart is performed in the 
card.

4. Accept - The new installed load is made the primary load. The user 
can no longer revert to the old load unless a complete downgrade 
is performed.
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An additional Abort step can be used to abort an upgrade in progress, 
an revert back to the old load.

Note: Software upgrade of cards in the MG 9000 must be performed 
in the following order DS1, ABI, ITP, ITX, DCC.

There are two ways to perform a software upgrade. 

•  with user interaction - The user must enter separate commands to 
perform the download, apply, and accept steps.

•  without user interaction - The user enters a single command to 
perform the download, apply, and accept steps.

Upgrade version rules

The software upgrade application requires the following version order 
when an upgrade is performed to a load with the same version or to 
higher version load.

• DS1 or ABI

• ITP

• ITX

• DCC

Note 1: The MG 9000 supports in-service upgrades from SN06.x to 
SN07. The Silence Suppression variables (used in the UA-IP solution 
only) will be set to default when the upgrade occurs. To reset the 
Silence Suppression variables, go to “Provisioning switched lines 
services” in MG 9000 Configuration Management, NN10096-511.

Note 2: When it is necessary to downgrade to SN06.x, perform the 
Downgrading the MG 9000 from SN07 to SN06.x on page 138 
procedure.

Note 3: During a downgrade, attempting to upgrade cards to a 
version lower than the DCC card is not supported.

Upgrades - the supported upgrade path for the MG 9000 is from SN06 
to SN07 for the UA-IP solution and from SN06.2 to SN07 for the 
UA-AAL1 solution.

Downgrades - the supported downgrade path for the MG 9000 is from 
SN07 to SN06.2 for UA-AAL1 and SN07 to SN06 for UA-IP.
NN10048-461   (I)SN07   Standard 06.02 December, 2004



Nortel Networks Confidential99Copyright © 2004, Nortel Networks
Software Upgrade View

This section provides an overview of the Software Upgrade tool in the 
MG 9000 Manager.

The software upgrade is performed using the Software Upgrade tool. 
The Software Upgrade tool is accessed from the MG 9000 Manager. 
When accessed, the Software Upgrade View appears. The Software 
Upgrade view is accessed from the 

• Card View for upgrading a single card, protection group, or all cards 
of the same type

• Frame View for upgrading multiple card types 

The following figure shows accessing Software Upgrade from the 
Actions pull-down menu from the Card View

Software upgrade accessed from Card View

The following figure shows accessing Software upgrade from the 
Actions pull-down menu from the Frame View.

Software upgrade accessed from Frame View
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The Software Upgrade view contains the following four panels

• Upgrade Originator panel - displays the name and number of the 
MG 9000 where the upgrade is taking place and the location of the 
view from which the upgrade command was invoked

• Upgrade State - displays text fields with information about an 
upgrade in progress which includes the status and the action being 
performed or just completed. The action and upgrade type fields are 
updated when the upgrade request is confirmed. The upgrade 
status is updated as upgrade steps are performed.

• Upgrade Type Data - displays data used to perform the upgrade. 
The text fields in this panel are updated when the configure step is 
completed. When the upgrade is for a single card type, protection 
group, or single card it includes text fields for the cards being 
upgraded, the load server, the user identifier that is used to access 
the load server, and the full path to the load name. The text field 
upgrading indicates the cards being upgraded as follows

— For a single card upgrade, this field displays the location of the 
card being upgraded.

— For an active/inactive pair of mate cards, the shelf location 
followed by the two slot numbers is displayed.

— For a card type upgrade, the card type being upgraded is 
indicated.

• Upgrade Instructions & Results - displays the results of an upgrade 
step and instructions for the next step to perform

Seven buttons are provided in the lower area of the view to enable the 
user to perform commands. The buttons are described in the following 
table.

Software Upgrade View buttons and descriptions

Button Description

History This button creates a new view that shows the upgrade history for the 
given MG 9000. Refer to Upgrade history on page 145.

Refresh This button updates the Software Upgrade View.
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<upgrade 
step>

This is the second button from the left. This button is used to perform an 
upgrade step. It changes its label depending on the next step to be 
performed. It is greyed out when the step is no longer valid. 

The labels assumed by this button are described as follows:

• Configure - The upgrade step button is set to this label when the view 
is first created, and after an abort is completed. 

— When pressed on the Software Upgrade accessed from the Card 
View, the Card Upgrade Wizard is created. 

— When pressed on the Software Upgrade accessed from the 
Frame View, the Card Type Selector view is created. 

See section Upgrade Wizard overview on page 112. If another user 
is performing a software upgrade, a message is output indicating the 
tool is in use and the Configure button is disabled.

• Upgrade - The Upgrade step button appears when an upgrade 
without user interaction is chosen. This step accomplishes the 
actions described in the following three buttons that appear when 
user interaction is selected.

The following labels appear when user interaction is selected:

• Download (not applicable to the Software Upgrade accessed from 
the Frame View) - The upgrade step button is set to this label when 
the upgrade wizard finishes the configuration for an upgrade with 
user interaction. When pressed, the MG 9000 is requested to perform 
a download. The parameters provided by the upgrade wizard are 
sent to the MG 9000 in the download request.

• Apply (not applicable to the Software Upgrade accessed from the 
Frame View) - The upgrade step button is set to this label when the 
MG 9000 completes the download step successfully. When this 
button is pressed the MG 9000 is requested to apply the load to the 
card previously downloaded.

• Accept (not applicable to the Software Upgrade accessed from the 
Frame View) - The upgrade step button is set to this label when the 
MG 9000 completes the apply step successfully. When this button is 
pressed, the MG 9000 is requested to accept this load as the primary 
load.

Version 
List

View all versions of the cards.

Software Upgrade View buttons and descriptions

Button Description
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The following figure shows the Software Upgrade View accessed from 
the Card View.

Abort This button is used to request the MG 9000 perform an abort. The button 
is enabled when an upgrade without user interaction is executed, and 
when the download step for an upgrade with user interaction is 
performed. It remains enabled until an abort is initiated or the accept step 
of the upgrade is initiated. In certain situations, such as when a fault on 
a card cannot be corrected, the MG 9000 cannot abort and revert back 
to the old loads. If the abort fails and there is no other way to stop the 
upgrade, use the Reset Upgrade System command located on the 
MG9000 History view (refer to Upgrade history on page 145). 

Close This button is used to close this view. It is disabled while the upgrade is 
in progress. The button is enabled when an accept or an abort step is 
completed.

An upgrade view can also be closed by the Close command in the 
window menu. A Close command is also provided in the MG 9000 menu. 
For the last two cases the Close command is not disabled when an 
upgrade is in progress. 

Retry This button is enabled only if a step in the upgrade process fails. Retry 
is used to continue an upgrade action from the place where it stopped 
after the customer has corrected the problem.

Software Upgrade View buttons and descriptions

Button Description
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Software Upgrade View accessed from Card View

When performing an upgrade of multiple card types, from the Frame 
View of the MG 9000 to be upgraded, select Actions->Software 
Upgrade. The Software Upgrade View accessed from the Frame View 
appears as shown in the following figure.
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Software Upgrade View accessed from Frame View

The following figure shows the Subnet View with the download icon on 
top of the MG 9000 on which a software download is in progress. The 
download icon also appears at the card and shelf views. The icon 
remains until the upgrade is complete or an abort completes.
NN10048-461   (I)SN07   Standard 06.02 December, 2004



Nortel Networks Confidential105Copyright © 2004, Nortel Networks
Subnet View showing download icon

The following figure shows the version list that appears in response to 
selecting the Version List button on the Software Upgrade View. The 
version list shows all common cards on the selected MG 9000 and the 
software version of the loads in the card.

Version list
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Software upgrade errors and problem resolution

The following table lists the errors that may arise at various steps in the 
MG 9000 software upgrade process, the cause, and recovery actions. 

MG 9000 software upgrade errors and problem resolution

Error type Cause Recovery action

Upgrade provisioning errors

Invalid file type This error is received if 
the card type selected is 
invalid for the load file 
name provided. Every 
load file name has the 
card type embedded 
within it.

Ensure the load file name is valid for the 
card type to be provisioned, then try 
again.

Invalid Version This error is received if 
the version number 
embedded within the 
load file name is invalid 
for this gateway. For 
example, if it is only 
valid to upgrade to 
versions 5 or 6 and the 
loadfile name contains 
version 8, an error is 
displayed.

Ensure the load file name version is 
valid for the attempted upgrade, then try 
again.

Invalid State This card is locked or 
active.

If this card is active and does have a 
mate, the request will be denied. First 
Swact/Spare the card to its mate and 
continue.

If this card is inactive, but locked, first 
unlock the card and continue.
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Download errors

FTP server 
related

Possible causes: 

• incorrectSDM 
loadfile/path 
permissions

• floating IP 
configuration error

• network connection 
failure identified 
during the 
provisioning activity

Abort the upgrade. Check provisioned 
data for validity and provision another 
upgrade.

Corrupt File This error may be due 
to:

• provisioning an 
incompatible load 
file for this card. For 
instance, if the card 
type is ITP, the load 
file name must 
include ITP. The 
same is true for 
other cards.

• insufficient memory 
for an image file

Abort the upgrade. 

• For the incompatible load file error, 
check the file name type and 
provision another upgrade.

• For the insufficient memory error, go 
to dshell and do a filesys/finfo and 
look a the freespace on the volume. 
It should be about three times the 
size of the image file.

Node Not 
Responding

The card may be 
undergoing a 
maintenance operation 
or is in an otherwise 
invalid state (such as, 
restarting) or may not be 
running.

Go to the Card View and verify the card 
status, if the card status appears correct 
the error may have been due to an 
longer than expected communication 
delay. Abort the upgrade and try again

Apply errors

State If this card is Active, an 
Apply will fail if this card 
has a mate.

Abort the upgrade. Cause a redundancy 
action (Swact or Spare) to occur. This 
card may have been Inactive during the 
provisioning of the upgrade. A 
redundancy action may have occurred 
which would be the reason the card is no 
longer Active.

MG 9000 software upgrade errors and problem resolution

Error type Cause Recovery action
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Node Not 
Responding

This card may be 
undergoing a 
maintenance operation, 
is in an otherwise invalid 
state (such as, 
restarting) or may not be 
running.

Go to the Card View and verify the card 
status, if the card status appears correct 
the error may have been due to an 
longer than expected communication 
delay. Abort this upgrade and try again

SwactDataSync 

Multi-Node Only

Mate cards in a 
protection group are 
NOT in data sync, a 
required Swact has 
failed or will not be 
executed

Go to the Card View and lock the card, 
then go to the Card View for the Inactive 
mate and unlock the card. The unlock 
action will cause a restart (since they are 
not in data sync).

Once the Inactive card has completed 
its restart, attempt to Abort.

Note: If after multiple tries data sync is 
not achieved, contact Nortel Networks 
for further guidance - additional 
upgrades are not possible until this is 
resolved.

SwactMateState 

Multi-Node Only

For reasons other than 
not in DataSync, the 
Active card refuses to 
give up activity (possibly 
due to faults on the 
inActive card).

Determine what the fault state or 
problem with the inActive card is and 
correct it.

Once the inActive card is in a valid state, 
you may then again attempt to Abort.

Note: If you cannot correct the error, 
contact Nortel Networks for further 
guidance - additional upgrades are not 
possible until this is resolved. 

SwactMateUnav
ailable 

Multi-Node Only

A communication 
problem exists between 
the Inactive and the 
Active cards. A Swact is 
not allowed.

Resolve the communication problem.

Once the Inactive card is in a valid state, 
attempt to Abort.

Note: If you cannot correct the error, 
contact Nortel Networks for further 
guidance - additional upgrades are not 
possible until this is resolved. 

MG 9000 software upgrade errors and problem resolution

Error type Cause Recovery action
Upgrading the MG 9000



109Copyright © 2004, Nortel Networks Nortel Networks Confidential
SwactError 

Multi-Node Only

A generic error 
associated with a Swact 
request, but enough 
information cannot be 
obtained for the 
Upgrade subsystem to 
identify the cause.

Contact your maintenance administrator 
to identify and resolve the problem. 

Once the card(s) are in a valid state, 
attempt to Abort.

Note: If you cannot correct the error, 
contact Nortel Networks for further 
guidance - additional upgrades are not 
possible until this is resolved.

Generic See Above Contact Nortel Networks.

Accept errors

Node Not 
Responding

The card may be 
undergoing a 
maintenance operation, 
is in an otherwise invalid 
state (such as 
restarting) or may not be 
running.

Go to the Card View and verify the card 
status, if the card status appears correct 
the error may have been due to an 
longer than expected communication 
delay. Abort the upgrade and try again

GENERIC See Above Contact Nortel Networks.

Abort errors

Node Not 
Responding

The card may be 
undergoing a 
maintenance operation, 
is in an otherwise invalid 
state (such as 
restarting) or may not be 
running.

Go to the Card View and verify the card 
status, if the card status appears 
correct, the error may have been due to 
an longer than expected communication 
delay. Abort this upgrade and try again.

MG 9000 software upgrade errors and problem resolution

Error type Cause Recovery action
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SwactDataSync Mate cards in a 
protection group are 
NOT in data sync, a 
required Swact has 
failed or will not be 
executed

Go to the Card View and lock, then go to 
the Card View for the inActive mate and 
unlock the card. The unlock action will 
cause a restart (since they are not in 
data sync).

Once the inActive card has completed 
its restart, you may then again attempt 
to Abort.

Note: If after multiple tries data sync is 
not achieved, contact Nortel Networks 
for further guidance - additional 
upgrades are not possible until this is 
resolved. 

SwactMateState For reasons other than 
not in DataSync, the 
Active card refuses to 
give up activity (possibly 
due to faults on the 
Inactive card).

Determine what the fault state or 
problem with the inActive card is and 
correct it.

Once the Inactive card is in a valid 
attempt to Abort.

Note: If you cannot correct the error, 
contact Nortel Networks for further 
guidance - additional upgrades are not 
possible until this is resolved. 

SwactMateUnav
ailable

There is a 
communication problem 
between the Inactive 
and Active cards. A 
Swact is not allowed.

Resolve the communications issue

Once the Inactive card is in a valid state, 
again attempt to Abort.

Note: If you cannot correct the error, 
contact Nortel Networks for further 
guidance - additional upgrades are not 
possible until this is resolved. 

MG 9000 software upgrade errors and problem resolution

Error type Cause Recovery action
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SwactError This is a generic error 
associated with a Swact 
request, but enough 
information cannot be 
obtained for the 
Upgrade subsystem to 
identify the cause.

Contact your maintenance administrator 
to identify and resolve the problem. 

Once the card(s) are in a valid state, 
attempt to Abort.

Note: If you cannot correct the error, 
contact Nortel Networks for further 
guidance - additional upgrades are not 
possible until this is resolved. 

GENERIC See Above Contact Nortel Networks

MG 9000 software upgrade errors and problem resolution

Error type Cause Recovery action
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Upgrade Wizard overview

This section provides an overview of the upgrade wizard which is 
accessed from the Software Upgrade View. 

The Software Upgrade View contains the following text fields:

• MG 9000 Name - provides the name and number of the MG 9000 
selected for upgrade

• Originating view - provides the frame view of the MG 9000 view from 
which the software upgrade request has been originated

• Upgrade status - is set to Waiting for Configure

• All other fields are blank and then updated when the configuration 
step is completed and the Configure button is enabled. The user is 
instructed to perform the Configure step in the Upgrade Instructions 
& Results texts area. The following figure shows the Software 
Upgrade View.

Software Upgrade View
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After clicking Configure, the Upgrade Wizard appears. The upgrade 
wizard is available in two forms, Card Upgrade Wizard and MG 
Upgrade Wizard, depending on how it was accessed. These two are 
described in the sections that follow.

Card Upgrade Wizard
This section provides an overview of the Card Upgrade Wizard. The 
Card Upgrade Wizard is accessed from the individual card view by 
selecting Actions->Software Upgrade from the menu bar and clicking 
on Configure in the Software Upgrade View. 

The upgrade wizard consists of four panels. Each panel is a step in the 
card upgrade wizard and all steps are discussed next.

• The first Card Upgrade Wizard step (step 1) allows the user to 
specify the upgrade type by clicking on the pull down. The following 
three upgrade types are available:

— card type - upgrade the individual card from which this panel was 
launched

— protection group - upgrade the card from which this panel was 
launched and its redundant mate (though this option is available 
in the Card upgrade wizard, it is recommended that upgrades of 
a protection group be performed using the MG Upgrade Wizard 
on page 119.)

— all cards of this type - upgrade all cards of the selected type in 
the MG 9000 (though this option is available in the Card upgrade 
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wizard, it is recommended that upgrades of all card of a given 
type be performed using the MG Upgrade Wizard on page 119.)

The upgrade procedures for protection group and all card type 
upgrades are similar to the upgrade procedures for single card 
upgrades. The difference are:

— upgrading of multiple cards instead of a single card with upgrade 
icon appearing on all cards being upgraded

— Swact occurs without user intervention as part of the upgrade

Card Upgrade Wizard, Step 1

• The next Card Upgrade Wizard step (step 2) allows the user to enter 
a load server IP address, a userid and password to be used to 
access the load server. The last six entries for the server IP address 
are remembered. The user can select between the last six entries 
or enter a new one. The user is not allowed to move to the next panel 
until all the entries on this panel are completed with valid data. If the 
entered IP address, userid, or password are not valid, an error 
message appears and the user must correct the entry for the 
upgrade process to proceed to the next step. The following figure 
shows the Card Upgrade Wizard, Step 2.
Upgrading the MG 9000
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Card Upgrade Wizard, Step 2, select a load server

• The next panel (step 3) allows the user to enter the directory and 
load name to be used for the upgrade. In the SN06.2 and SN07 
version, if the entered directory is incorrect, a message appears to 
inform the user and the directory must be corrected for the upgrade 
to proceed. 

Card Upgrade Wizard, Step 3, specify a load (SN06 version)

When upgrading from SN06 to SN07, the SN06 version of the Card 
Upgrade Wizard appears (no List button). Enter the load name. The 
load name is parsed for the version number. A valid string for the 
load name consists of the card type in uppercase followed by the 
version.
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On the SN06.2 or SN07 version of the Step 3, click on the List button 
to retrieve the files from the SDM and the combo box is populated 
with MG 9000 patched image (9PI) file names (identified by the .tar 
extension on the filename). Choose a file from the list. The following 
figure shows Step 3 of the Card Upgrade Wizard.

Card Upgrade Wizard, Step 3, specify a load (SN06.2 version)

• The next panel (step 4) prompts for the user to select between 
performing the upgrade with user interaction or without user 
interaction. The following figure shows Step 4 of the MG Upgrade 
Wizard.
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Card Upgrade Wizard, Step 4, interactive download

— Perform upgrade without user interaction - It is recommended 
that this mode is used. When selecting this mode, after the user 
clicks Finish, the system responds with an Upgrade button on 
the Software Upgrade View. After the user clicks Upgrade, the 
system continues with the successful completion of each action, 
the next action automatically executes without any input needed 
from the user. The exception to this, is if an error occurs. Then 
the upgrade stops and the user must click Abort. Error 
messages will be output. Refer to Software upgrade errors and 
problem resolution on page 106 for information on responding to 
errors. 

— Perform upgrade with user interaction - When selecting this 
mode, the system responds with a Download button on the 
Software Upgrade View. The system then prompts for an Apply 
followed by an Accept. Like the previously discussed upgrade 
without user interaction, refer to Software upgrade errors and 
problem resolution on page 106 for information on responding 
any errors that may occur. 

Note 1: If a “Protection group” or “All cards of this type” 
upgrade is selected, during the Download action/phase of the 
upgrade, only one designated card gets the new software from 
the load server. All other cards involved with the upgrade get 
the new software from that card. 

Note 2: If a “Protection group” or “All cards of this type” 
upgrade is selected, during an upgrade, a controlled, non-user 
Upgrading the MG 9000
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requested Swact occurs. The system raises redundancy 
notifications as normal while Apply action is occurring, only an 
encountered error terminates its progress.

The user interaction is as follows:

– Apply - After the system successfully completes the 
Download, the system prompts the user to click Apply. Apply 
causes the card to restart. After the restart has completed, 
the card will be executing the new, upgraded software. An 
automatic SWACT and restart of the mate occurs as part of 
the Apply action. (Not applicable to single card upgrades.)

– Accept - After the system successfully completes the Apply 
the system prompts the user to click Accept. Accept causes 
the card to complete its upgrade activity which takes a few 
seconds. The system notifies the user when the Accept is 
completed. Exit the upgrade view by pressing Close. Verify 
the upgrade is complete by viewing History.

• After clicking Finish, the Upgrade Wizard disappears and the 
Software Upgrade View prompts the user to click Download (with 
user interaction) or Upgrade (without user interaction) to start the 
upgrade process. Upgrade progress is reported in the Upgrade 
Instructions & Results window of the Software Upgrade View.
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MG Upgrade Wizard
This section provides an overview of the MG Upgrade Wizard. The MG 
Upgrade Wizard is accessed from the Frame View by selecting 
Actions->Software Upgrade from the menu bar and clicking on 
Configure in the Software Upgrade View. 

The upgrade wizard consists of multiple steps (panels), depending on 
the actions chosen in step 1. Each panel is a step in the MG Upgrade 
Wizard and all steps are discussed next.

• The first MG Upgrade Wizard step (step 1) allows the user to specify 
All Card Types, one card type, or multiple card types. The MG 
Upgrade Wizard will upgrade the software in all cards of the 
selected type. The following figure shows the MG Upgrade Wizard, 
Card Type Selection, Step 1.

MG Upgrade Wizard, Step 1, card type selection, multiple cards

The MG Upgrade Wizard contains a list of card types available to be 
upgraded on the given MG 9000. One or more than one card types 
can be selected for upgrade. The user can also select all the card 
types on a given MG 9000 by selecting All Card Types. The check 
box “Use one load server only” is provided to specify a single or a 
different load server for each card type. The default value is to use 
the same load server for all card types.

• The next MG Upgrade Wizard (step 2) allows the user to enter a 
load server IP address, a userid and password to be used to access 
the load server. The last six entries for the server IP address are 
remembered. The user can select between the last six entries or 
enter a new one. A user is not allowed to move to the next panel until 
all the entries on this panel are completed with valid data. The 
following figure shows the MG Upgrade Wizard, Step 2.
Upgrading the MG 9000
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MG Upgrade Wizard, Step 2, select a load server

The panels that follow the first panel depend on the selections made 
on the first panel. If the selection “Use one load server only” is 
selected, the load server panel for a single load server will be 
displayed when the button Next is pressed. The load server panel 
contains the server address, user identifier and password for the 
load server where the load for the selected card type is contained.

If Use one load server only is not selected in the card type selection 
panel, a separate Load Server and Specify a Load panels are 
added to the wizard for each card type selected. This allows the use 
of a different server for each card type selected. For example, if the 
ITX and ITP card types are selected, the panels displayed after the 
card type selection panel are: the ITX Load server panel, followed 
by the ITX Specify a Load panel, followed by the ITP Load server 
panel, and finally followed by the ITP Specify a Load panel.

When the load server panel is completed and Next is pressed, the 
Load Information panel is displayed. It provides the directory and 
load name. If only one card type is selected in the card type 
selection panel this is the last panel in the wizard. The Finish button 
is enabled. The user Interaction panel is not provided in the MG 
Upgrade Wizard because the multi card type upgrade only supports 
upgrades without user interaction. When Finish is selected, the load 
name is checked for a valid version range. When the check passes, 
the wizard is removed and the user is prompted to start the upgrade 
for the selected card type.

If more than one card type is selected, or all card types are selected, 
an additional Load Information panel is added to the wizard for each 
card type selected. For example, if all card types are selected the 
second panel is the Load server panel as in the previous case, 
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followed by the Load Information panel for ABI (if installed), followed 
by the Load Information panel for DS1 (if installed), then ITP, then 
ITX, and finally OC3 (or DS1-IMA). When the Specify a Load panel 
for the last card type is completed Finish is pressed from the ABI 
Specify a Load panel. The load names entered for the selected card 
types are checked for version range validity after the Next button is 
pressed on each card type configuration panel. (See Upgrade 
version rules on page 98.) After the load is validated, the wizard is 
removed and the user is prompted to start the upgrade.

• The next MG Upgrade Wizard step (step 3) allows the user to enter 
the directory and load name to be used for the upgrade. Like the 
Card Upgrade Wizard discussed earlier, if the entered directory is 
incorrect, a message appears to inform the user and the directory 
must be corrected for the upgrade to proceed. 

When upgrading from SN06 to SN07, the SN06 version of Step 3 
appears. Enter the load name. The load name is parsed for the 
version number. A valid string for the load name consists of the card 
type in uppercase followed by the version.

MG Upgrade Wizard, Step 3, Specify a load (SN06 version)

The following figure shows the MG Upgrade Wizard, Step 3, Specify 
a Load.
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MG Upgrade Wizard, Step 3, Specify a load (SN06.2 version)

On the SN06.2 version of the MG Upgrade Wizard, Step 3, click on 
the List button to retrieve the files from the SDM and the combo box 
is populated with 9PI file names (identified by the .tar extension on 
the filename). Choose a file from the list.

This step will continue to increment until the loads are specified for 
each card type that is part of the upgrade. When the load for last 
card in the upgrade is specified, click Finish.

• When the configuration steps are completed, the MG Upgrade 
Wizard is closed and the third pane in the Software Upgrade view is 
modified to display the upgrade data for all the card types selected 
for upgrade. The Software Upgrade View is shown in Software 
Upgrade View accessed from Frame View on page 104 with a 
multiple card types upgrade running. The MG 9000 can only 
upgrade one card type at a time, so the MG 9000 Manager 
automatically schedules the upgrade for the selected card types in 
sequence. The third pane contains the card type for which the 
upgrade is in progress in the MG 9000.

The third pane also contains a tabbed panel with a tab for each card 
type selected for upgrade. Each tabbed entry contains the load 
server, the user identifier, and the full path load name for that card 
type. The card type being upgraded is on the top of the tabbed pane.
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Card upgrade with user intervention

When to use this procedure
Use this procedure when it is necessary to upgrade a single card in an 
MG 9000. This procedure provides the steps to perform a software 
upgrade in a single DCC, ITP, ITX, ABI, or DS1 card with user 
interaction.

Note: This procedure applies to single card upgrades only, not 
multiple card upgrades.

Prerequisites
Clear all alarms on the card to be upgraded before proceeding with the 
upgrade process.

Action

Card upgrade with user intervention

At the MG 9000 Manager

1 From the Subnet View, select the network element (NE) 
containing the card to be upgraded. Double click on the NE icon 
and the Frame View appears. 

2 Double click on the shelf containing the card and the Shelf View 
appears. 

3 Double click on the card to be upgraded and the Card View 
appears. 

4 At the Card View of the card selected for upgrade click the 
Actions menu.

5 At the Actions menu select Software Upgrade... The Card 
Upgrade view is created as described in Software Upgrade View 
on page 99.

There are three possible messages in the Card Upgrade View at 
the time it is created:

• If a previous user closed the view before an abort was 
completed, the abort may still be in progress. An indication to 
wait until the abort is completed is displayed. In this case, the 
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Configure button is disabled. Either wait for the abort to 
complete or close the view.

A message will appear notifying when the abort is 
completed, and the Configure button is enabled.

• Another user is performing an upgrade on a card on the 
same MG 9000. In this case, the user can close the view or 
abort the upgrade in process and start a new upgrade.

• If no upgrade activity is in progress on the selected MG 9000, 
the user is prompted to press the Configure button to start 
the upgrade.

• If the floating IP address has not been provisioned, the 
system prompts you to provision it. After the floating IP 
address is provisioned, continue with the procedure.

6 Press the Configure button to start the Upgrade wizard. The 
upgrade wizard is created as described in Upgrade Wizard 
overview on page 112.

7 Enter the parameters in the first three panels as described in 
Upgrade Wizard overview on page 112.

8 Select Perform Upgrade with user interaction in the last panel. 
Press Finish to completed the configuration. The user is 
returned to the Card Upgrade View. The following figure shows 
the Upgrade View with the system prompting the user to press 
the Download button.
NN10048-461   (I)SN07   Standard 06.02 December, 2004



Nortel Networks Confidential125Copyright © 2004, Nortel Networks
Software Upgrade View

9 Press Download to request the MG 9000 to perform the 
download step. When the download is complete, the results are 
Upgrading the MG 9000
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displayed in the result area of the Software Upgrade View as 
follows:

• The download step was successful. The step button changes 
to Apply. The user is prompted to perform the Apply step

• The download step failed. An indication of the failure is 
indicated. Possible cause of failure could be:

— communication problems between the GUI client and the 
mid-tier layer, between the mid tier layer and the MG 9000 
Manager, between the MG 9000 Manager and the 
MG 9000.

— invalid configuration parameters. The user could abort 
the upgrade. When the upgrade is aborted, the step 
button changes back to Upgrade.

10 Press the Apply button for the MG 9000 to perform the apply 
step. When the apply is completed the results are displayed in 
the result area of the card upgrade view as follows:

• The Apply step was successful. The step button changes to 
Accept. Go to step 11.

• The Apply step failed. An indication of the failure is indicated. 
Possible cause of failure could be:

— communication problems between the GUI client and the 
mid-tier layer, between the mid tier layer and the MG 9000 
Manager, between the MG 9000 Manager and the 
MG 9000. The user must abort the upgrade. After that it 
could configure again or close. 

— card is locked or involved in a maintenance activity. The 
system prompts to unlock or wait until the maintenance 
activity is completed. Press Apply again.

11 Press Accept to complete the upgrade. The Accept and Abort 
buttons are disabled. When the Apply is completed, the results 
are displayed in the result area of the card upgrade view as 
follows:

• The accept step was successful. Close the Upgrade View.

• The accept step failed. An indication of the failure is 
indicated. Possible cause of failure could be communication 
problems between the MG 9000 Manager client and the 
mid-tier server, between the mid-tier server and the master 
server, between the master server and the MG 9000. Abort 
the upgrade. Abort the upgrade by pressing the Abort button 
to cancel the remainder of the upgrade.Configure again or 
close.
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12 When the accept is completed, close the upgrade view. Apply 
patches. Refer to “Applying patches using the NPM GUI” 
procedure in ATM Solutions Upgrades, NN10261-450 or IP 
Solutions Upgrades, NN10344-450 for patching procedures.

13 This procedure is complete.
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Card upgrade without user intervention

When to use this procedure
Use this procedure when it is necessary to upgrade the software in a 
single card without user intervention. This procedure provides the steps 
to perform a software upgrade in a single DCC, ITP, ITX, ABI, or DS1 
card without user interaction.

Note: This procedure applies to single card upgrades only, not 
multiple card upgrades.

Prerequisites
Clear all alarms on the card to be upgraded before proceeding with the 
upgrade process.

Action

Card upgrade without user intervention

At the MG 9000 Manager

1 From the Subnet View, select the network element (NE) 
containing the card to be upgraded. Double click on the NE icon 
and the Frame View appears. 

2 Double click on the shelf containing the card and the Shelf View 
appears. 

3 Double click on the card to be upgraded and the Card View 
appears. 

4 At the Card View of the card selected for upgrade click the 
Actions menu. 

5 At the Actions menu select Software Upgrade... The Software 
Upgrade view is created as described in Software Upgrade View 
on page 99. The Software Upgrade View appears as shown 
next.
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Software Upgrade View

There are three possible messages in the Software Upgrade 
View at the time it is created:

• If a previous user closed the view before an abort was 
completed, the abort may still be in progress. An indication to 
wait until the abort is completed is displayed. In this case, the 
NN10048-461   (I)SN07   Standard 06.02 December, 2004



Nortel Networks Confidential130Copyright © 2004, Nortel Networks
Configure button is disabled. Either wait for the abort to 
complete or close the view.

A message appears notifying when the abort is complete, 
and the Configure button is enabled.

• Another user is performing an upgrade on a card on the 
same MG 9000. In this case, the user can close the view or 
abort the upgrade in process and start a new upgrade.

• If no upgrade activity is in progress on the selected MG 9000, 
the user is prompted to press the Configure button to start 
the upgrade.

• Select Upgrade to continue with the upgrade without user 
interaction. If the floating IP address has not been 
provisioned the user is prompted to provision it. After that, 
continue with the upgrade procedure.

6 Press the Configure button to start the Upgrade wizard. The 
Card Upgrade Wizard appears. See Upgrade Wizard overview 
on page 112.

7 Enter the parameters in the first three panels as described in 
Upgrade Wizard overview on page 112.

8 Select “Perform Upgrade without user interaction” in the last 
panel. Press Finish to complete the configuration.

9 Messages indicating the progress of the upgrade, download, 
apply, and accept steps are displayed. If a step fails, a message 
is displayed indicating the reason. The user can abort and 
perform the configure step again or close the view. 

The download icon appears in the Shelf View and the Card View. 
The icon remains until the upgrade is completed or aborted.
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Shelf View and Card View with download icon

10 When the accept is completed, close the upgrade view. Apply 
patches. Refer to “Applying patches using the NPM GUI” 
procedure in ATM Solutions Upgrades, NN10261-450 or IP 
Solutions Upgrades, NN10344-450 for patching procedures.

11 If problems occur, abort the upgrade by pressing the Abort 
button to cancel the remainder of the upgrade.

12 This procedure is complete.

Software download icon
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MG upgrades

When to use this procedure
Use the following procedure when it is necessary to upgrade the 
software in multiple cards and protection groups without user 
intervention. This procedure provides the steps to perform a software 
upgrade in DCC, ITP, ITX, ABI, and DS1 cards without user interaction.

Prerequisites
Clear all alarms on the cards to be upgraded before proceeding with the 
upgrade process.

If this procedure is part of the SN06 to SN06.2 upgrade, ensure the NE 
has been exported and the floating IP address has already been 
provisioned.

Action

MG upgrades

At the SN06.x MG 9000 Manager

1 At the Frame View of the MG 9000 selected for upgrade click the 
Actions menu.

2 At the Actions menu select Software Upgrade... The MG 9000 
Software Upgrade view is created as described in Software 
Upgrade View on page 99

3 Check the Upgrade Originator pane in the MG 9000 Software 
Upgrade View to ensure the MG 9000 Name and Originating 
View (NE number) represent the MG 9000 to be upgraded.

4 Press the Configure button to start the MG Upgrade wizard. The 
MG Upgrade Wizard, Card Type Selection, Step 1 appears.

5 Select the card types to upgrade or select all card types by 
selecting All Card Types. A check appears in the appropriate box 
next to the selection.

6 Select Use one load server only to use the same load server for 
all card types. This is the default. To specify a different load 
server for each card type, deselect this box. The MG Upgrade 
Wizard will update to reflect the number of steps in the upgrade 
process.
NN10048-461   (I)SN07   Standard 06.02 December, 2004



133Copyright © 2004, Nortel Networks Nortel Networks Confidential
Use the following table to determine the next step.

7 In the MG Upgrade Wizard, Select a load server, enter the 
server address, user identifier, and password for the load server 
where the load for the selected card type is contained. Click 
Next.

8 In the MG Upgrade Wizard, Specify a load, the directory and 
load name are provided. The upgrade now begins. Go to step 
11.

9 In the MG Upgrade Wizard, Select a load server, enter the 
server address, user identifier, and password for the load server 
containing the loads for all the card types to be upgraded.

The system then responds with the MG Upgrade Wizard, 
Specify a load, in which the directory and load name are entered 
for the card type (such as, SC0A07AZ_GZ.tar). The system 
repeats this step in succession for each card type in the following 
order: DS1, ABI, ITP, ITX, and DCC. The load names are 
checked for version range validity. 

The MG Upgrade Wizard closes, the MG 9000 Software 
Upgrade View appears with the Upgrade Type Data panel 
updated to display the upgrade data for all the card types 
selected for upgrade and reports the card type for which the 
upgrade is in progress in the MG 9000. Go to step 11.

Note: The MG 9000 upgrades one card type at a time. The 
MG 9000 Manager schedules the upgrade for the selected 
card types in sequence.

10 In the MG Upgrade Wizard, Select a load server, enter the 
server address, user identifier and password for the load server 
that contains the image file must be entered.

The system then responds with the MG Upgrade Wizard, 
Specify a load, in which the directory and image load name are 
entered for the card type (such as, SC0A07AZ_GZ.tar). The 
system repeats this step in succession for each card type in the 
following order: DS1, ABI, ITP, ITX, and DCC. The load names 
are checked for version range validity. 

If upgrading Do

only one card type using one load 
server

step 7

multiple card types using one load 
server

step 9

multiple card types specifying a 
different load server for each card 
type

step 10
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The MG Upgrade Wizard closes, the MG 9000 Software 
Upgrade View appears with the Upgrade Type Data panel 
updated to display the upgrade data for all the card types 
selected for upgrade and reports the card type for which the 
upgrade is in progress in the MG 9000.

Note: The MG 9000 upgrades one card type at a time. The 
MG 9000 Manager schedules the upgrade for the selected 
card types in sequence.

11 This procedure is complete.
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Upgrading the MG 9000 from SN06.x to SN07

When to use this procedure
Use the following procedure when it is necessary to upgrade the 
MG 9000 from SN06.x to SN07 using MG 9000 Patch Image load files. 

Note: The MG 9000 cards are upgraded in the following order: DS1, 
ABI (DS-512), ITP, ITX, and DCC.

What is an MG 9000 Patch Image (9PI) load file?
A 9PI is a pre-patched MG 9000 load image file and is identified by the 
.tar extension on the filename. The patches contained in the image are 
not required to be applied following the upgrade. However, patches for 
the MG 9000 are administered using the Network Patching Manager 
(NPM) patching system so the NPM needs to be taught about the 
applied patches. Any device that has been upgraded to a pre-patched 
load must be audited (by the NPM) following the upgrade for the NPM 
to determine the patch content. Any pre-applied patches need to be 
placed in the NPM database (using the getpatch command). Also, any 
additional patches required but not included in the image will need to 
be applied. For information and procedures for patching the MG 9000 
software using the NPM, refer to ATM Solutions Upgrade, 
NN10261-450 or IP Solutions Upgrade, NN10344-450.

To display the content of an SN07 patched image without having to load 
the file into a card and have the NPM perform an audit, login to the 
machine where the load files are located, change to the directory where 
the load file resides and enter the following at the command line on one 
line:

> strings SC0A07BB_GZ.tar | awk 
‘/patchlist_begin/’/patchlist_end/’ 

where SCOA07BB_GZ.tar is an example of a patched image file name
Upgrading the MG 9000



Nortel Networks Confidential136Copyright © 2004, Nortel Networks
The following is an example of the output in response to the previous 
command:

patchlist_begin
SCO01UBB
SCO02UBB
SCO03UBB
SCO04UBB
SCO05UBB
SCO06UBB
SCO07UBB
SCO10UBB
SCO12UBB
SCO13UBB
SCO17UBB
patchlist_end

Prerequisites
Perform the upgrade in the SN06.x Subnet View.

Ensure the NE has been exported and the floating IP address has 
already been provisioned.

Action

Upgrading the MG 9000 from SN06.x to SN07

At the MG 9000 Manager

1 At the Frame View of the MG 9000 selected for upgrade click the 
Actions menu.

2 At the Actions menu select Software Upgrade... The MG 9000 
Software Upgrade view is created as described in Software 
Upgrade View on page 99.

3 Check the Upgrade Originator pane in the MG 9000 Software 
Upgrade View to ensure the MG 9000 Name and Originating 
View (NE number) represent the MG 9000 to be upgraded.

4 Press the Configure button to start the MG Upgrade wizard. The 
MG Upgrade Wizard, Card Type Selection, Step 1 appears.

5 Select “All Card Types” to upgrade all cards. A check appears in 
the box next to the selection.

6 Select “Use one load server only” to use the same load server. 
Click the Next button.
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7 In the MG Upgrade Wizard, Select a load server, enter the 
server address, user identifier, and password for the load server 
where the SN07 load for the selected card type is contained. 
Click Next.

8 In the MG Upgrade Wizard, for each card specify an SN07 load, 
the directory and load name are provided. Respond to each step 
requesting the load name for the card. Ensure you use the latest 
pre-patched image load file provided by Nortel located on the 
SDM in directory /swd/mg9k/. The following represent SN07 
load names, though the ones listed here may not be the latest 
available:

• DS1G07AZ_GZ 

• ABIG07AZ_GZ 

• ITPA07AZ_GZ 

• ITXA07AZ_GZ 

• SCOA07AZ_GZ (DCC-OC3) or 
SCIA07AZ_GZ (DCC DS1-IMA) 

Click on Next and repeat this step for each card type. Click on 
Finish.

9 At the Software Upgrade View, click on Upgrade to start the 
upgrade process. 

Note: All upgraded nodes (cards) display a major alarm 
which remains until the NE is controlled by an upgraded 
MG 9000 Manager.

10 This procedure is complete. 

If the MG 9000 Manager is a one-server configuration, go to step 
8 on page 16 of the MG 9000 Manager and MG 9000 SN06.x to 
SN07 upgrade checklist (one-server) and continue with the 
upgrade process.

If the MG 9000 Manager is a two-server configuration, go to step 
13 on page 30 of the MG 9000 Manager and MG 9000 SN06.2 
to SN07 upgrade checklist (two-server) and continue with the 
upgrade process.
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Downgrading the MG 9000 from SN07 to SN06.x

When to use this procedure
Use the following procedure when it is necessary to downgrade the 
MG 9000 from SN07 to SN06.x using MG 9000 Patch Image load files.

Note 1: The MG 9000 cards must be downgraded in the following 
order: DCC, ITX, ITP, ABI (DS-512), and/or DS1.

Note 2: During a downgrade, the GWC cannot be downgraded until 
all MG 9000s that subtend from it are downgraded.

What is an MG 9000 Patch Image (9PI) load file?
A 9PI is a pre-patched MG 9000 load image file and is identified by the 
.tar extension on the filename. The patches contained in the image are 
not required to be applied following the upgrade. However, patches for 
the MG 9000 are administered using the Network Patching Manager 
(NPM) patching system so the NPM needs to be taught about the 
applied patches. Any device that has been upgraded to a pre-patched 
load must be audited (by the NPM) following the upgrade for the NPM 
to determine the patch content. Any pre-applied patches need to be 
placed in the NPM database (using the getpatch command). Also, any 
additional patches required but not included in the image will need to 
be applied. For information and procedures for patching the MG 9000 
software using the NPM, refer to ATM Solutions Upgrades, 
NN10261-450 or IP Solutions Upgrades, NN10344-450.

Prerequisites
Ensure the MG 9000 to be downgraded does not exist in the SN07 
Subnet View.

WARNING
Loss of clock synchronization
If the MG 9000 must be downgraded from SN07 to 
SN06.x, and the MG 9000 is synched to DCCBits 
(external timing), the BITS interface cable must be 
transferred from the DCC cards (RJ45 connector) to 
the ITX cards (DB9 connector with wire-wrap). The 
technician must manually provision ITXBits timing 
using the local craft interface (LCI). Refer to MG 9000 
Configuration Management, NN10096-511. If the 
MG 9000 was provisioned for Network (internal 
timing), no changes are required.
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Ensure the downgrade is performed from the SN06.x Subnet View.

Ensure the PEC codes are not for new SN07 hardware by checking the 
hardware versions. If the new hardware is not removed, the SN06.x 
loads will fail to load with a corrupt loadfile error.

Ensure that if the OC-3 ports have been channelized, they are manually 
unchannelized prior to downgrading.

Action

Downgrading the MG 9000 from SN07 to SN06.x

At the MG 9000 Manager

1 At the Frame View of the MG 9000 selected for upgrade click the 
Actions menu.

2 At the Actions menu select Software Upgrade... The MG 9000 
Software Upgrade view is created as described in Software 
Upgrade View on page 99.

3 Check the Upgrade Originator pane in the MG 9000 Software 
Upgrade View to ensure the MG 9000 Name and Originating 
View (NE number) represent the MG 9000 to be upgraded.

4 Press the Configure button to start the MG Upgrade wizard. The 
MG Upgrade Wizard, Card Type Selection, Step 1 appears.

5 Select All Card Types to downgrade all cards. A check appears 
in the appropriate box next to the selection

6 Select Use one load server only to use the same load server. 

7 In the MG Upgrade Wizard, Select a load server, enter the 
server address, user identifier, and password for the load server 
where the SN06 load for the selected card type is contained. 
Click Next.

8 In the MG Upgrade Wizard, for each card specify an SN06.x 
load, the directory and load name are provided. Respond to 
each step requesting the pre-patched image load file for the 
card. Ensure you use the correct pre-patched load on the SDM 
in directory /swd/mg9k/. The following represent SN06 load 
names, though the ones listed here may not be the latest 
available:

• SCOA06DN_GZ.tar (DCC-OC3) or SCIA06DN_GZ.tar (DCC 
DS1-IMA)

• ITXA06DN_GZ.tar

• ITPA06DN_GZ.tar
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• DS1G06DN_GZ.tar

• ABIG06DN_GZ.tar

Click on Finish. 

9 At the Software Upgrade View, click on Upgrade to begin the 
downgrade. The downgrade process starts.

10 Downgrade the software in the MTA and xDSL cards to SN06.x 
loads using the Downloading software into the MTA card on 
page 141 and Downloading software into the xDSL card on 
page 143 procedures. 

Note: Perform the downgrade of the MTA card and xDSL card 
from the SN06.x Subnet View.

11 This procedure is complete.
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Downloading software into the MTA card

When to use this procedure
Use this procedure when it is necessary to update software onto an 
MTA card. The Software Download Manager menu option provides 
access to a Software Download Manager window.

Prerequisites
If the software download is part of the SN06.x to SN07 upgrade, ensure 
the floating IP address has already been provisioned.

Action

Downloading software into the MTA card

At the SN06.x MG 9000 Manager

1 At the Subnet View, double click on the MG 9000 that has the 
MTA card to which software is to be downloaded. The Frame 
View appears.

2 At the Frame View, double click on the shelf in which the MTA 
card resides. The Shelf View appears.

3 At the Shelf View, double click on the slot in which the MTA card 
resides. The card view appears.

4 To request a download, select the Locked option for the 
Administrative Status in the Status box. The card must be 
Locked prior to requesting a download.

5 From the MTA Card View menu level, select Actions->Software 
Download Manager

6 Enter data in the fields as follows:

• File Path - the path and name of the file on the SDM to be 
downloaded to the card (/mg9k/<loadname>)

• IP address - the file location (IP address)

• Server userName - the login name for the server where load 
resides

• Server password - the password for the server where load 
resides

• select Force Download if forced download is required

7 Select the Download button at the bottom of the Software 
Download Manager window. 
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Once the download is complete, the Load Status field indicates 
if the download was successful, and the software load being 
used by the card is displayed under Restart Current in the 
Software Load pane. 

Note: After the software download is performed, a message 
appears stating that the MTA card is restarted.

Perform the download again, since the MTA card has a Primary 
and Backup load. When a download is performed, the Primary 
load becomes the Backup load and the new load becomes the 
Primary load. Performing the download twice makes the new 
load the Primary and the Backup load and guarantees the 
current load is the new load.

8 After the second download is complete, from the MTA Card View 
set the Administrative Status of the MTA card to Unlocked by 
selecting the Unlocked option in the Status box.

9 This procedure is complete. If this action is part of an MG 9000 
upgrade, return to the upgrade checklist to continue with the 
upgrade process.
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Downloading software into the xDSL card

When to use this procedure
Use this procedure when it is necessary to download updated software 
onto an xDSL card. The Software Download Manager menu option 
provides access to a Software Download Manager window.

Prerequisites
Perform this activity during periods of low traffic.

If the software download is part of the SN06.x to SN07 upgrade, ensure 
the floating IP address has already been provisioned.

Action

Downloading software into the xDSL card

At the SN06.x MG 9000 Manager

1 At the Subnet View, double click on the MG 9000 that has the 
xDSL card to which software is to be downloaded. The Frame 
View appears.

2 At the Frame View, double click on the shelf in which the xDSL 
card resides. The Shelf View appears.

3 At the Shelf View, double click on the slot in which the xDSL card 
resides. The card view appears.

4 To request a download, select the Locked option for the 
Administrative Status in the Status box. The card must be 
Locked prior to requesting a download.

5 From the xDSL Card View menu level, select Actions->Software 
Download Manager

6 Enter data in the fields as follows:

• File Path - the path and name of the file to be downloaded to 
the card (/mg9k/<loadname>)

Note 1: For cards with no patchables (no .tar file), include 
the .bin extension (such as, DSLA07BW.bin) as 
/mg9k/DSLA07BW.bin. 

Note 2: In certain offices, the file path may be /swd/mg9k/

• IP address - the file location (IP address)
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• Server userName - the login name for the server where load 
resides

• Server password - the password for the server where load 
resides

• select Force Download if forced download is required. The 
force option is needed only when the card must be reloaded 
with the same load that already exists on the card.

7 Select the Download button at the bottom of the Software 
Download Manager window. When the download begins the 
download icon appears on the card.

Once the download is complete, the download icon disappears 
and the initialization icon appears. Once initialization is 
complete, the icon disappears and the software load used in the 
card is displayed in the Software Load section of the Card View.

8 If necessary, repeat steps 3 through 7 for all xDSL cards in the 
MG 9000 network element that must be upgraded. Otherwise 
skip this step.

9 Unlock the cards that were locked in step 4.

10 This procedure is complete. If this action is part of an MG 9000 
upgrade, return to the upgrade checklist to continue with the 
upgrade process.
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Upgrade history

The Upgrade History is a view that is accessed from the Software 
Upgrade View that reads information about upgrades performed on an 
MG 9000. The Upgrade History contains: 

• the time the upgrade was performed

• the type of upgrade

• the card the upgrade was performed

• the full path of the load name

• the final status

All the entries status is completed or aborted. The last entry may have 
a different status since an upgrade is in progress.

The following buttons are provided in the Upgrade History:

• Delete - used to delete a history entry. An attempt to delete an entry 
for an upgrade in progress will fail.

• Refresh - used to update the view with the latest data since the view 
is not dynamically updated.

• Close - used to exit the Upgrade History view.

From the menu bar, the following MG9000 items are available

• Close - used to exit the Upgrade History view

• Reset Upgrade System - used to reset the upgrade system back to 
idle (that is, the upgrade process is abandoned where it is). This 
action could leave the cards in a mixed state, and the loads in the 
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cards will not be reverted back to the original loads. Clear the card 
fault or replace the faulty card and try the upgrade again. 

The following figure shows the Reset Upgrade System command.

Reset Upgrade System command

The Reset Upgrade System command requires emsadm 
permission and is considered a drastic step. Do not use this 
command unless directed to do so by Nortel Networks customer 
support.

The following figure shows the warning message that appears when 
the Reset Upgrade System command is used.

Reset Upgrade System command warning

The following figure shows the History View.
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Software upgrade History View
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Patching the MG 9000

The MG 9000 is patched using the Network Patching Manager (NPM) 
patching system. Any device to be patched must first be audited to 
determine the load name compatibility with the patch before applying 
the patch. 

For information and procedures for patching the MG 9000 software 
using the NPM, refer to the Succession Patching chapter in ATM 
Solutions Upgrades, NN10261-450 or IP Solutions Upgrades, 
NN10344-450.
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